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Introduction

Welcome to Train Signal!

This series of labs on Windows 2000 is designed to give you detailed, hands-on experience
working with Windows 2000. Train Signal’s Audio-Visual Lab courses are targeted towards
the serious learner, those who want to know more than just the answers to the test
questions. We have gone to great lengths to make this series appealing to both those who

are seeking Microsoft certification and to those who want an excellent overall knowledge of
Windows 2000.

Each of our courses put you in the driver’s seat, working for different fictitious companies,
deploying complex configurations, and then modifying them as your company grows. They
are not designed to be a “cookbook lab,” where you follow along with the steps of the
“recipe” until you have completed the lab and have learned nothing. Instead, we
recommend that you perform each step and then analyze the results of your actions in detail.

To complete these labs yourself, you will need three computers equipped as described in the
Lab Setup section. You also need to have a foundation in Windows 2000 and TCP/IP
concepts. You should be comfortable with installing Windows 2000 Professional or Server
and getting the basic operating system up and running. Each of the labs in this series will
start from a default installation of Windows 2000 and will then run you through the basic
configurations and settings that you must use for the labs to be successful. It is very
important that you follow these guidelines exactly, in order to get the best results from this
course.

The course also includes a CD-ROM that features an audio-visual walk-through of all of the
labs in the course. In the walk-through, you will be shown all of the details from start to
finish on each step, for every lab in the course. During the instruction, you will also benefit
from live training that discusses the current topic in great detail, making you aware of many
of the fine points associated with the current topic.

Thank you for choosing Train Signall
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Setting up the Lab

1. Computer Equipment Needed

GNAL. .

Item Minimum Recommended
Computers (3) Pentium I 133 MHz (3) Pentium II 300MHz or greater
Memory 128 MB 256 MB
Hard Drive 2GB 4 GB or larger
NIC 1/machine 1/machine
Hubs 1 1
Network Cable | (3) Category 5 cables (3) Category 5 cables

I strongly urge you to acquire all of the recommended equipment in the list above. It can all
be easily purchased from eBay or another source, for around $500 (less if you already have
some of the equipment). This same equipment is used over and over again in all of Train
Signal’s labs and will also work great in all sorts of other network configurations that you
may want to set up in the future. It will be an excellent investment in your education. You
may also want to look into a disk-imaging product such as Norton Ghost. Disk imaging
software will save you a tremendous amount of time when it comes to reinstalling Windows

2000 for future labs.

products that are very inexpensive.

Page 10 of 85

Many vendors offer trial versions or personal versions of their

© Train Signal, Inc., 2002



P N

WTrainsi

2. Computer Configuration Overview

GNAL. .

Computer
Number

Computer Name

SRV-1

SRV-11

Client-1

IP Address 192.168.1.201/24 192.168.1.211/24 192.168.1.1/24
OS W2K Server W2K Server W2K Pro
Additional SP2 SP2 SP2
Configurations

3. Detailed Lab Configuration

***Important Note***

This lab should NOT be performed on a live production network. You should only use computer
equipment that is not part of a business network AND is not connected to a business network.
Train Signal Inc., is not responsible for any damages. Refer to the full disclaimer and limitation of
liability which appears at the beginning of this document and on our Website, www.trainsignal.com.

Computer 1

Computer 1 will be named SRV-1 and the operating system on this computer will be
Windows 2000 Server or Advanced Server. You should also install Service Pack 2 to avoid
any unforeseen problems. If you do not have a copy of Windows 2000 Server you can
obtain an evaluation copy of Windows 2000 Advanced Server within the Microsoft Press
seties of books, and Service Pack 2 is available for download on Microsoft’s Website.

SRV-1 will have a static IP address of 192.168.1.201 with a 255.255.255.0 subnet mask. The
default gateway field can be left blank but you should enter this computer’s own IP address
for the Preferred DNS field (192.168.1.201). The alternate DNS Server field can be left
blank. See figure 1, next page.
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Computer 2
Computer 2 will be named SRV-11 and Windows 2000 (either version once again) will be

installed on this computer with Service Pack 2. SRV-11 will have a static IP address of
192.168.1.211 with a 255.255.255.0 subnet mask. The default gateway field can be left blank
but you should configure the preferred DNS server setting to point to SRV-1, 192.168.1.201
and leave the alternate DNS setting blank. See figure 1, next page.

Computer 3
Computer 3 will be named Client-1 and have Windows 2000 Professional installed as the

operating system. Client-1 will have a static IP address of 192.168.1.1 with a 255.255.255.0
subnet mask. The default gateway field can be left blank but you should configure the
preferred DNS server setting to point to SRV-1, 192.168.1.201 and leave the alternate DNS
setting blank. See figure 1, next page.

Important - You should test the network connections (using the PING command) between

each of these machines to ensure that your network is set up properly. Testing before you
get started will save you major time and effort later.

Page 12 of 85 © Train Signal, Inc., 2002
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[ ctve Directory |
Lab Setup

=2 Hub
Computer Name: SRV-1
Static IP: 7192.168.1.201/24
OS: W2K Server/SP2
Services:
DNS
Domain Controller A=—
8 E;
E°3 Computer Name: Client-1
Static IP: 192.168.1.1/24
N : SRV-11
g&rzzllj;grm;r;rgs? 211/24 0S: W2K Professional/SP2
OS: W2K Server/SP2
Services:
File Server
(figure 1)

***Important Note***

This lab should NOT be performed on a live production network. You should only use computer
equipment that is not part of a business network AND is not connected to a business network.
Train Signal Inc., is not responsible for any damages. Refer to the full disclaimer and limitation of
liability which appears at the beginning of this document and on our web site, www.trainsignal.com.
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LLab 1

Creating an Active Directory Domain for
Ben & Brady’s Ice Cream, Corp.

You will learn how to:

e Install Active Directory
e Configure and test DNS for Active Directory
e Join clients and servers to the domain
e Add additional domain controllers to the domain
e Test Active Directory replication between domain controllers

Page 15 of 85 © Train Signal, Inc., 2002
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Scenario — Part One

Ben & Brady’s Ice Cream Corp., is a manufacturer of gourmet ice cream products that are
sold internationally. They are in the process of migrating their network from Novell to
Windows 2000 as well as replacing all of their current servers with new equipment. Their
main headquarters is located in San Francisco and they have a manufacturing facility in
Charlotte, North Carolina. The San Francisco office is connected to the Internet with a full
T1 (1.544 Mbps) and Microsoft’s ISA Server (firewall) will protect the internal network. The
facility in Charlotte is used to manufacture ice cream and ship to Ben & Brady’s East Coast
distributors. The San Francisco office has five servers that have just been purchased; all will
be running Windows 2000 Server and also 25 workstations that will be running Windows
2000 Professional. The Chatlotte location also has five new servers that were recently
purchased, all running Windows 2000 Server and 45 workstations, all running Windows
2000 Professional. Charlotte is connected to the Internet with a Fractional T1 (768 Kbps)
and they also use ISA Server to protect their internal network. The two locations will be
connected together through a VPN that is formed between the two ISA Servers over the
Internet.

Ben & Brady’s Ice Cream Co. has hired you on a contract basis, to help with the
implementation of a new pristine Windows 2000 domain. You have been given the task of
installing the first domain controller on the network at the San Francisco office, which will
install Active Directory and create a new domain for Ben & Brady’s Ice Cream Co. You are
also in charge of making sure that all client computers, which have been installed, are able to
join the new domain. The Operations Manager, Jill, also mentions that there is an
opportunity for you to become a full time administrator with the company, if the project
goes well.

In this lab, you will create a new domain for Ben & Brady’s Ice Cream Co., called
benandbrady.com, by building the first domain controller on the network using the Active
Directory installation program. You will then configure DNS to work with Active Directory
and test that it is working propetly on the network using the NSLOOKUP utility. Once
your domain controller is working propetly, you will join a Windows 2000 server and a
Windows 2000 Professional machine to the domain. Finally, you will create a second
domain controller on your domain and test replication between the two domain controllers.
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Benandbrady.com

Internet

San Francisco , CA Charlotte, NC

= = Window 2000 Windows 2000
i indow
Window 2000 Windows 2000 N Servers
i Professional
Professional Servers 0
Workstations Workstations

Active Directory Replication

Domain Controller Domain Controller

In lab 1 you will configure SRV-1 & SRV11 as domain controllers.
Then test the Active Directory replication between both servers.
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Active Directory

Active Directory is a new feature in Windows 2000 that allows users to logon and access
resources from anywhere in the network. It allows administrators to manage the network
from a single location and makes network security much easier to manage. Active Directory
is really a database that stores information about all objects on the network. Think of Active
Directory as a phone book for the network. For example, if you needed to find a resource
on the network but you can’t remember where it is located, you can do a search in Active
Directory to find that resource. Resources include users, groups, computers, printers, and
shared folders, to name a few. The Active Directory database is stored on Windows 2000
servers known as Domain Controllers. All of the domain controllers within a domain hold
the same copy of the Active Directory database, in a file named NTDS.DIT. Windows 2000
domain controllers are multi-master replication partners, all replicating data back and forth
to each other.

Installing Active Directory

1. Log on to stv-1 and open the run command. From the desktop click on Start=>Run then
type in DCPROMO in the run command and click OK.

Type the name of a program, Folder, document, or
Internet resource, and Windows will open it For wou,

Open:

Il

Ok I Cancel | Browse. .. |

2. 'This will begin the Active Directory installation wizard. The first screen to appear is the
welcome screen, click on Next to continue. The next screen will ask you for the type of
domain controller you would like to install. You have two options; one is to install this
as the first domain controller for a new domain or as an additional domain controller for
an already existing domain. This is the first domain controller on the network, select
Domain controller for a new domain and click Next.

[ Active Directory installation Wizard 3

Domain Contiolies Typn
Seecly the 1ol you wank it server 1o have.

Do you veant this b domae et o doman of &0
‘sddtonsl domain contsoler for an edtting domain?

% [horruer comiisber box 3 rosey chriises
5 Few boresl
That gmives

1 fiBonial oo cortioer hin an fossting doman
P " ol ke -
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The next screen will ask you to specify whether you want to create a new domain tree or
create a new child domain in an existing domain tree. In Windows 2000 you can build
domain trees so that the domains are in a hierarchy, for domains to be in a tree they
must have a contiguous (continuous) namespace. The first domain in a tree is known as
the root domain and any child domains in the tree will have to contain the name of the
root domain. For example TRAINSIGNAL.COM may have a child domain for a
Chicago office with the name of CHL.TRAINSIGNAL.COM and would be considered
part of the domain tree because it has the contiguous namespace of the root domain,
TRAINSIGNAL.COM. Remembert, that this is the first domain controller on the
network, so it will be the “root” domain of a new tree. Select Create a new domain
tree and click Next.

Active Directory Installation Wizard g x|

Create Tree or Child Domain /
‘fiou can create a new domain free o & new child domain,

tiee

1F you don't want the new domain ta be a child of an existing domain, select this
option. This wil create 2 nev domain tree that is separate from any existing trees.

‘rou can then choose to place the new domain tres in an existing forest, o create a
e forest

£ Cieate a new child domain in an existing domain tiee

1F you want the e domain to be a child of an existing domain, select this option
Far example, you could create a new darnain named

headguarters. example. microsoft.com as 4 child domain of the domain
exxample.miciosoft.com.

< Back I Hext » &! Cancel

The next screen asks you if you would like to create a new forest or join an existing
forest. Windows 2000 lets you place the domain trees into forests, if there are any
existing forests. Forests are used when you would like to combine two domain trees that
have a non-contiguous namespace. For example TRAINSIGNAL.COM and SAS-
TA.COM may not be placed in a domain tree together, because of the non-contiguous
root domain names, but they may be a part of a forest that contains domain trees. You
are creating the first and only tree with the benandbrady.com domain. Select Create a
new forest of domain trees and click Next.

e

Lamate vs Juin Furest
Spedy e loeaton of e nev doman

ik

¥

% [Cimate a rew lovest of doman beed
Select this ootion # thit i the first domes qerizefion, o i
"
forest.
™ Plbce thit new domsin iee in an &xisting forest
Select Wi option 1 in ' aconss 10
cBack |, Hewt> | Concel |
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5. The next screen will ask you to specify the full DNS domain name for your new domain.
You do not have to use your company’s registered public (Internet) domain name here,
but you can if you would like. For this lab, type in benandbrady.com and click Next.

6. The next screen will ask you to specify the NetBIOS name for the domain. This is the
domain name that legacy systems (anything before Windows 2000) and applications that
only support NetBIOS will use. The main difference is that the NetBIOS domain name
can only contain up to 15 characters with no periods. By default the wizard will suggest
a name for you, based on the domain name you entered earlier, only now it will use the
NetBIOS name rules. In this case, it should come up as BENANDBRADY. You can
modify this name if you would like, but it would most likely lead to confusion down the
road, as your domain will effectively have two names. Leave the default name,
BENANDBRADY. Click on Next.

fuctive Directory Installation Wizsrd

HetBIDG Demain Mame
Speciy a NeI15 narme lor the rew doman,

doman, Clck Hest 12 acoept the nane shown, o hpe 4 rew name.

Do NelBIDS ruame: [BENANDERALY

_cbes [ ] | cwen

7. The next screen will ask where you want to place the Active Directory database and log.
It's recommended in a production environment, that you place the log file on a separate
physical hard drive to increase the performance of Active Directory. This is optional for
the lab, if you do not have two physical hard drives you can leave it at the default setting
which will be the %systenroot’%\WINNT\NTDS for both the database and the log, or
c\WINNT\NTDS. Click Next.

I —

Database and Log Locstions
Sgmpecty the ko ates of the Active Desctin dalsbaie ard kg

For
o ks

Totabase locomr™y
T To%

< Conce
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8. The next screen will ask you for the location of the SYSVOL folder. This system folder
stores any user configurations, default profiles, and logon scripts that you may have on
the network. The folder is automatically shared and replicates to other domain
controllers throughout Active Directory. The default location of the folder is
Yosystemrooto\WINNT\SYS1/OL but you may still change the location of the folder.
You always want to try to keep things as simple as possible so leave the default location
for the folder and click Next.

T S—

Shated Systom Yolume
Spsciy e bkda b be shared as the syetem vohame.

sterms thar . « The corieeis of

The Syevel fokder muit be located an a0 NTFS 5.0 wokare.
Ender a lozanon lor the Sypo elder

Feledet kocalbors

| BT Byowran

9. A dialog box will appear and tell you the wizard was unable to find the DNS server that
handles the name benandbrady.com and then ask you to confirm that the DNS
configuration is working propetly, or install and configure a DNS server on this
computer. Active Directory was designed to work with DNS and will not function
without a DNS server that handles name resolution for the domain. Click OK.

* Active Directory Installation Wizard |

The wizard cannot contact the DMNS server that handles the name "benandbrady. com" to determine if it supports
dynamic update. Confirm wour DNS configuration, or install and configure a DMS server on this computer,

10. Within the wizard, you will see a screen asking if you would like to install and configure
DNS on this computer now or if you would like to install and configure DNS yourself.
If you select yes, the wizard will install DNS for you but if you select no it will end the
wizard and tell you that it cannot continue and the Active Directory installation will fail.
Let the wizard install and configure the DNS server for you. Select Yes, install, and
configure DNS on this Computer and click Next.

Active Directory Installation Wizard

Contigure DHS

The wazard can corfiuee (NS lor your rew dormar

[ ' DONS smever
[ Ee—r——)

 fex. raisl i compuber
T Mg | villinctsl snd configuse DNS mysel

< Back. [ gm
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11. The next screen will ask you what the default permissions should be for users and
groups. The first option is for permissions compatible with pre-Windows 2000 servers.
This setting will loosen up security a little, but it will allow NT 4.0 RAS servers and other
programs to be able to authenticate users. The second option is for permissions
compatible only with Windows 2000 servers. This will give you tighter security but will
not work with any N'T 4.0 RAS servers and can cause problems within NT 4.0 domains.
There are no NT 4.0 servers of any kind in the network, nor do you ever plan on having
any on the network, so you may choose the second option of Permissions compatible
only with Windows 2000 servers and click Next.

Peimssions
Sintact el pprmisons bot Lnes s groasp obreces

Some sereer programa, puch ot Windows NT flamobs Accers Serece, sad infomston
ttornd on dorman coniolers.
o Permirsions compatble v preWindows 2000 e
Sebect ths opsen i 2000
‘Windewrs 2000 servers that are members of peewindows 2000 domans.

A A o
1 Ppmitaions compatble ork veth Wit 2000 serestd

o
2000 demars. D
oty doman,

Iz
s [ ] e

12. The next screen will ask you for a directory services restore mode administrator
password. This password is used to protect against anyone other than an administrator
from rebuilding the Active Directory database from the directory services restore mode.
This password is different from any logon password and should be a different from the
administrator’s logon password in case the administrators’ account gets compromised.
Type in pass as the password and click Next.

Arirve Drectory Installation Wizard

« Back Heot > Carel

13. The next screen will give you a summary of all the information you entered in the
wizard. Review and confirm that everything is correct and click Next to start the Active
Directory installation. You may be asked for the 7386 folder during the installation of
DNS, so you should have the Windows 2000 Server CD-Rom handy. The installation
should take about 15-30 minutes.

Configuring Active Directory...

The wizard is configuring Active Ditsctory. This process can taks several
minutes or considerably longer, depending on the oplions you have selected
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14. You will eventually get a screen letting you know the installation is done. Click on
Finish and you will see a dialog box appear telling you that the server must be restarted
before the changes made by the Active Directory installation wizard take effect. Click
Restart Now for the computer to restart.

Active Directory Installation Wizard x|

Completing the Active Directory
Installation wizard

Active Directory Installation Wizard x|

Windows must be restarted before the changes made by the Active
Directory Installation wizard take effect.

Restart Now I Don't Restart How
JIRCE N I |

Configuring DINS to work with Active Directory

1. When the server restarts, log on as administrator and open the DNS management
console. Go to Start>Programs—>Administrative Tools>DNS. In the left pane
open srv-1, then open Forward Lookup Zones folder and find the zone for
benandbrady.com. Check to make sure there is a host entry for srv-1.

O o

| & console  window  Help | =1=1]

[ aton wen || & =» |BE| XEFRE 2

Tree | Name [ Type [ Data [
3 _msdcs

T (2 _siees

=0 Forward Lookup Zones || _tep
_udp

ndbrady com (same as parenk falder) Start of suth...  [23], srv-L benandbrady co. .
Lackup Zones (same as parent: folder) Mame Server  srv-1.benandbrady.com.
(same as parent folder) Host 192.168.1.201
EIEE Host 192.168.1.201

2. Right click on the benandbrady.com and select Properties. Here you can see that
when DNS is installed automatically through the Active Directory installation wizard, the

zone type is set to Active Directory-integrated and dynamic updates are set for Only secure
updates by default. Click OK.

2
WINS | Zone Transters I Security 1
General | stanorutheiysoar | Name Servers
Status:  Running
Tupe Active Directorirtegrated Change.

Datajis stored in Active Directory.

Allow dynamic updates? Only secure updates

. click Aging Aging

Ta set aging/scavenging proper

ok | Eaneel | seew |
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3. Now you will need to create a reverse lookup zone for the benandbrady.com network.
The reverse lookup zone is needed in order to use the NSLOOKUP utility to test that
DNS is working properly and troubleshoot any problems that may arise. Right click on
the Reverse Lookup Zones folder, select New Zone and the Reverse lookup zone
wizard will start.

(eons
Jﬁq Console  Window  Help
“ Action  Wiew H@' -D||||

Tree I

Te @
2§ srv-1

EH:I Forward Lookup Zanes
D oadE .

The Do
divided
mare o

Wigw 3
New Window fram Here

Refresh

Help

4. 'The first screen is the welcome screen, just click on Next. The next screen will ask you
to specify the type of zone you want to create. Choose the same type of zone that the
forward lookup zone is set to. Select Active Directory integrated, by selecting an
Active Directory integrated zone, dynamic updates will automatically be set to allow On/y
secure updates, click Next. The next screen will ask you to specify the Network ID for
the reverse lookup zone. Type in the network ID 192.168.1 and click Next. The last
screen will show a summary of all the information you entered on the wizard, confirm
that it’s all correct and click Finish to create the reverse lookup zone.

remzoneweard A e
Fone Typs Hewverse Lookup Zone
» = and e ditesard ey A tevera kg Bore it an ke o

Sl the typeof 70w youa wank 33 crmn
[T e Wt D

Thi i 15z 158 1

hegpaned tiovage

St rinaey ¥ ou une 8 280 1 the etk D, £ vl appes i e core rame. o exainie,
- - et 1) 153 i crashe o 65 kel . st 10 16810 wouded

creal core (1168 radkh s

rheds £ Riveris bohu s s

 Standad seconday ERERE
© o o it e, Thi
f gy v v vk Ll b

l Rk Mot Cavcsl 2 < Mack Carcel

Completing the New Zone Wizard

Yo hawe nuzcesshily compbsied the Hiew Zone mzatd Yo
it e lideersy 2eflins

Hiame 1IELTAE sk ama
Tyee: #icive Dineciory Ineegraied Primary
Loskipips  Paveiss

Tor ehoom thit witared sl comat the reww 2o, chick Firich

i Bak Concel
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5. On the DNS console, open the Reverse Lookup Zones folder and you should find the
zone, 192.168.1.x Subnet. Open the Properties of the zone to confirm that the zone
type is set to Active Directory integrated and dynamic updates are set to allow only secure
updates. Close the Properties.

-10] x|
JH?I-‘ Console  Window  Help ‘;Iilﬁ”
H ain vew ||+ o |B[@ XEFREB 2 ‘
Tree I Mame: | Type | Data |
LS {same as parent folder) Startof Auth...  [1], srv-1.benandbrady.ca...
g- B SRY-1 {same as parent folder) Mame Server srv-1,benandbrady,com,

£ Forward Lookup Zones
CmE.

o @1 benandbrady.com
£ Revers

132

6. The next step is to create a pointer record for srv-1, this should be the only pointer
record you will have to create manually because any other clients that support dynamic
updates will automatically update and create their own host and pointer records. Srv-1
did not update or create a pointer record automatically because there was no reverse
lookup zone available when the host record was originally created. Right click on
192.168.1.x Subnet and select New Pointer.

J,Jg,‘ Console  window  Help

|J aion vew || &= = | E[m | X B

Tree I

(2, Dus
B srv-1
(=20 Forward Lookup Zones
R
F-{z) benandbrady.com
=] D Reverse Lookup Zones
: 197165, 1.x Subi
Update server Data Fils
Reload

New Alias...

Mew Domain. ..

New Delegation. ..
Other New Recards...

7. A dialog box will appear asking you for the Host IP address and Host name of the
Pointer record. Type in 201 for the host IP number and srv-1.benandbrady.com for
the host name then click OK.

[new biesourceRecord 2ix
Parte (PTH) |
Subewt
116R 150 invackk wpa
Herih IP b,
e
Heaut rame:
O T e [
L
Lo ] e |
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8. On the DNS console, you should now have a pointer record for 792.768.1.201. Close

the DNS Console.
| —1o| x|
J'Jg._| Console  wWindow  Help ‘;Iili”

|J Action  Wiew “ - -’|‘X |@

Tree I

2 DNS
=3 srv-1
=5 D Forward Lookup Zones

Mame

| Type | Data |

. |Z] {same as parent Folder’
. 2] (same as parent Folder)
@ 192,168.,1.201

Stark of Auth...
Mame Server
FPaointer

[1], srv-1.benandbrady.co...
srv-1.benandbrady.com,
stv-1.benandbrady.com

" benandbrady.com
=1 Reverse Lookup Zones
{3 [192.168.1.x Subnet

9. From the desktop, open the command prompt; go to Start=>Run, type in CMD and

click OK. On the command prompt type in NSLOOKUP and press Enter.
Run 21

3

Open: | cmd|

L3

Type the name of a program, folder, document, or : -
Internet resource, and Windows will open it For vou. INNT' System32'cmd.exe

crosoft Windows 2088 [Uersion 5.808.21951]
(C) Copyright 1985-280088 Microsoft Corp.

=

C:x>nslookup

o]

Cancel | Browse, .. |

10. The NSLOOKUP utility will look for the DNS server on the network and return the
host name and IP address of the server. You should have the default server srv-
1.benandbrady.com and an IP address of 192.168.1.201 appear. You may now type in
any host name and NSLOOKUP will query the preferred DNS server to resolve it to an
IP address. Try resolving the host name for srv-1. Type in srv-1 and press Enter. You
should get the full DNS name and IP address of the DNS server and underneath it will
appear the full DNS name and IP address of the queried host. Type in Exit and press
Enter to exit NSLOOKUP. Then type Exit and press Enter again to close the
command prompt.

WINNT System32'cmd.exe - nslookup

C:x2>ns lookup
Default Server: srv—1.benandbrady.com
Address: 192.168.1.201

sru—1 _benandbrady.com
192 _168_1._201

sru—1 _benandbrady.com
192 _168_1._201

Address:

>
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Joining clients and servers to the domain

1. Log on to client-1 and open the network identification tab from the System Properties.
On the desktop right click on My Computer and select properties. On the properties
page select the Network Identification tab. You will see that the full computer name is
client-1 and it is currently a member of the workgroup named workgroup, which is the

workgroup that Windows 2000 computers join by default unless otherwise specified
during the installation.

G T S — 2l
Explore Genenal  Metwerk Identficahon | Hadware | User Prefies | Advareed |
Search... .
D] Windows usas tha ellowing indoanation 10 ety pour conmgater
Manage o s stk
Map Metwork Drive. .. Fial compuli niams Chant),
. heek WOREGAOLUR

Disconneck Metwark. Drive. .. i

T e thee Metweth |dentiicstion Wieaid 1o for & Hetwosh [0
Create Shortcut borivein v ergale & botal upes, ek Metwer 10,
Rename

To soname ther congden of pon & demen, <k =
Propenes e |

Properties

2. To change the network ID information, click on the Properties button. On the
properties page you can change the computer name and the domain or workgroup that
the computer is a member of. Leave the computer name as client-1, for the Member of
option select Domain and type in benandbrady.com. Click OK and you will be
prompted to enter a username and password of an account that has permission to join
computers to the benandbrady.com domain. Enter the domain administrator’s
username and password for the benandbrady.com domain and click OK.

*k* N ote***

The administrator account for the benandbrady.com domain and the account for the local

administrator are not the same; it must be the administrator account that you use to log on to the
domain.

x|

and password of an account with permission ta jain the

Hame: [administrator

Passwan o | T

3. After you enter the name and password you should get a dialog box welcoming you to
the benandbrady.com domain. Click OK and you will get a couple more dialog boxes

saying that you must reboot the computer for changes to take effect. Click OK and Yes
until your computer reboots.

Nebtwork Identification
@ ‘welcome to the banandbrady.com domain.
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4. When the computer restarts make sure, you change the /Jogon on 0 dialog box to

6.

benandbrady. Use the administrative account from the domain (right now this may be
the same username/password as your local administrator account, but it is important to
distinguish the two) to logon to the benandbrady.com domain.

Once you logon, open the System Properties and select the Network Identification
tab. You should now see the full computer name as csent-1.benandbrady.com and the
domain as benandbrady.com. Click OK and log off client-1.

2

enersl Network Idertiication | Herdware | User Profiiss | Advanced]

S oW
-

Client-1. benandbrady. com

benandbrady. com
\wizard ta join & etwor
ick Metwark ID LSt ID

a rename this computer o join a domain, click Properties

The process for joining computers to the domain is the same for Windows 2000
Professional and Server. Now log on to srv-11 and make it a member server of the
benandbrady.com domain by using the same steps that you used to join the Windows
2000 Professional computer, client-1, to the domain.

Scenario — Part Two

Jill calls you into her office to discuss your progress with the new benandbrady.com domain.
She tells you that everything is looking good and informs you that she also wants a second
domain controller on the network for higher reliability and better performance. You agree
with her about adding the second domain controller and jump right into the new project.

Adding a second Domain Controller

Log on to the benandbrady.com domain with member server stv-11. Before attempting
to add a second domain controller to the domain, it is very important to verify that DNS
is working propetly on the server. You can do this by using the NSLOOKUP utility
from the command prompt and making sure that the default server and address appear
without any errors. You should have srv-1.benandbrady.com appear as the default
server with the IP address of 192.168.1.201. Exit NSLOOKUP and Close the command
prompt. If you receive errors at this point, it is very unlikely that the second domain
controller will be able to contact the first domain controller and replicate the Active
Directory database. You should attempt to fix this problem, which is more than likely
related to DNS, before you go on.

eeeee
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2. Adding another domain controller to a domain is done the same way as creating the first
domain controller, by running DCPROMO and using the Active Directory installation
wizard, only this time you will have to select different options in the wizard in order to
make srv-11 the second domain controller of benandbrady.com. You can start the
Active Directory installation wizard by running DCPROMO from the run command
prompt.

Type the name of a program, Folder, document, or
Internet resource, and Wwindows will open it for you,

=

Cancel | Erowse...l

3. The first screen on the wizard is the welcome screen, just click on Next to move on to
the following screen. On the second screen, you’re asked to specify whether this will be
a domain controller on a new domain or an additional domain controller for an existing
domain. Select Additional domain controller for an existing domain and click Next.

Active Wirectory Installation Wieard

Domain Contioller Type
Speeciy the role you want this server 1o have.

I Ppr— domes "
arddional domain conirolle lor an edsting doman?
™ Droman contraler fol & neter doman

Thit e firit s

1% hdditional dormain contiolst for an sxisting doman

coninung.
A enciyhed deta. such 8 EFS-anciyphed flss of emsl. shoukd ba decnyeted
coca_|

4. The next screen will ask you to specify a username, password and domain name for the
domain it will become a domain controller for. Type in the administrator’s username and
password for the benandbrady.com domain. benandbrady.com should appear by
default as the domain because this server is a member of the benandbrady.com domain
already. Click Next.

Active Directory Installation Wizard
Hetmork, Credentialy
Erorvde 3 rewo, user name arvd password

Ty the: ptced,
e fox s opesstion.

Uses novner [samnataios
Pasirort
Dioman: m
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5. The next screen will ask you to enter the full DNS name of the domain for which the

server will become a domain controller. By default it should already appear as
benandbrady.com because the server is already a member of this domain. Leave the
DNS name benandbrady.com and click Next.

5!

Ertter the full DNS name of the existing domair for which this server will become an
additional domain contraller (for example; headquarters. example.microsoft. com),

To view alist of existing domains. click Browse.

Domain name:

Browse.

< Back, I Next > I Cancel

The next screen will ask you to specify where to store the Active Directory database and
the Active Directory Log. By default they are both placed in the
%systemroot’e \WINNT\NTDS folder. Itis recommended that you place the
database and the log on separate physical hard drives for better performance. For this
lab leave the default location for both the database and the log and then click Next.

1,

Database and Log Locations )
Speciy the locations of the Active Directary database and log

For best perfomance and recoverabiity. store the databass and the log on ssparale

hard disks.

Wihere do you want to store the Aclive Directory daltabass?

D atabase location:

[EwHNTNTDS Browse:
‘Where do you want o store the Active Directory log?

Log location:

[ WIHNTNTDS Browse.

< Back Nest> Cancel

The next screen will ask you to specify the location of the shared system volume. The
default location is %systemroot% \WINNT\SYSVOL. Keep it simple by leaving the
default location for the shared system volume and click Next.

The next screen will ask you for a directory service restore mode administrator password. This
password will be asked for when starting the computer in directory services restore
mode or if the domain controller is being demoted. Use the same password that was
used in the first domain controller to be consistent. Type in pass as the password and
click Next.
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9. The next screen will be a summary of all the information you entered in the wizard.
Confirm that the information is correct and click Next.

| Active Directory Installation Wizard
Summary
Rewiew and confim the aptions pou selected

You chose oo
[Corfune this server a1 an s3anonsl doman Contiols K e doman. =]
LTI

D-atabase locasion: CAWINNTINTIS
Loy b keseaptiors CAWINKTANTDS
Syl fokder locaton: CAWINNTASYSVOL

]

T change an epbon, chck Back. To contrue, chok Hed.

i
<Ba|t.|Nw>| Erwall

10. The Active Directory installation will then begin and continue for about 15-30 minutes.
The final screen for the wizard will appear to let you know the installation is complete.
Click on Finish and a dialog box will appear telling you that the server must be restarted

in order for the changes made by the Active Directory wizard to take effect. Click on
Restart Now for the computer to restart.

Testing replication between the domain controllers

1. Log on to srv-1 and open the Active Directory Users and Computers console by going
to Start>Programs—> Administrative Tools=>Active Directory Users and
Computers. In the left pane of the console open the container named Domain
Controllers, all domain controllers in the benandbrady.com should appear in the details
pane on the right. You should see both s72-7 and srv-77 appear. By default, any domain
controllers on the network are placed in this container.

-.{; Active Directory Users and Computers ;IE

| Console  Window  Help |;|g
|J aton wew || €@ = |B@| X ER R Bl vEE

Tree I Domain Controllers 2 objects

tive Directory Users and Computers [srv-1.benandbrady, com] | T4ame [ Tvpe Description |
=& benandbrady, cam QSR'\:‘—I Computer
(13 Builtin = 5py-11 Computer

(23 Computers
Dornain Controllers
D ForeignSecurityPrincipals
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2. Now create a user account for Ben Smith to test replication between the two domain
controllers. Right click on the Users container in the left pane and select New=> Uset.

~lnix

| Gt g i
bom pem (e ORCFH R VENTEE

3. That will bring up a wizard for creating a new user. On the first screen type in the first
and last name for the user (Ben Swith) and for the logon name type in the first initial of
the first name and the full last name (bs#zith) and click Next. On the next screen you
must enter a password for the new user account. Type in mega as the password and
click Next.

New Object - User 25| B wews Object - User =

ﬁ Create in:  benandbrach. com/Users Q Cieatein:  benandbrady com/lsers

First name: Ben] Initials: Password

Last name: ISmlIh Confiim password:

Full Ben Smith
Ll name: | ™ User must change password at nest Ingan

User lagan name: I User cannat change passward

Ibsmllh | @henandbrady com | I~ Passwiord never expiies

User logon name (pre-windows 2000 I Accountis disabled

|BENANDBHADY\ Ibsmlth

< Back I Nest > é! Cancsl < Back, I Next > I Cancel

4. 'The final screen is just a summary of all the information that you entered in the wizard.
Confirm that the information is correct and click Finish. Then on the Active Directory
Users and Computers console there should be a user account named Ber Swith in the
Users container.

£
<5 Crevole m-m ﬂdn
g Create i benandbrady.com/Users | teton e || & = [Bm[ X 020885
'..,.,l Ligers LG oboscts
‘When you click Firish, the following object wil be cieated: 3 Rebve Direstory Users 30 o | ""' IType |[te=
e [ ke
Full name: Ben Smith -: (23 Bttn ﬂl Cort Publshers  Security Group ... Ente
%L1 Computers €3 Dnsicimins Security Group .. DRS
Uset logon name: bsmith@benandbrady.com (&3] Domasin Contralers DrsUpdateP... Secuily Grou .. DG
L Fereiriearkybrnopsts \fnomsin admng  Security Group ... Desit
o Users. T Domain Comp... Security Group .. Al
Durnsin Corkr,.. Security Groug . Ald
unen Gumsts Security Srou . Ald
Do Lisers Secunty Group ... Ald
€T Erenmeise Ad... Security Group ... Dest
g@mkﬁ.\rm Secuity Groun .. Merr
Gt ste ke
Ehetigt Liser Key
[ €T Ras and 145 ... Security Group ... Ser
<Back [Frsh ] Cancel gisau.—.a Fbie Secuiity Grou ... Desi
[\
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5. Now log on to stv-11 and open the Active Directory Users and Computers console
and then click on the Users container in the left pane. Now look into the Details pane
on the right and try to find the user account Ben Smith. It may or may not appear here.
It all depends on whether the domain controllers have replicated the Active Directory
database yet or not. There is no absolute time as to how often the domain controllers
replicate, they may replicate instantly or it may take up to about 5 minutes after a change
is made to the database. For the lab let us assume that the replication has not taken
place so your Active Directory Users and Computers console on srv-11 will not have the

user Ben Smith.

<% Active Directory Users and Computers:

[ Console  Window Help
|| acion wew || & = | @[m | > @2

Tree | Users 15 objects

[<5 active Directory Users | | ame Tz

=& benandorady.com || € Administrator  User
(3 Buitin Cort Publishers  Security Group
(2 Computers | | €FDnsaAdmins Security Group
#1-{s] Domain Control |€fDnsUpdatepr... Security Group
O Forsignsecurity | @ pomain admins  Security Group .
1o €7Domain Comp. . Security Group
€7 Domain Corkr... Security Group .
€TDomain Guests  Security Group
€ Domain Users  Security Group
€T Enterprise Ad... Security Group
€T Group Policy .. Security Group
€5 Guest User
€ lebrgt User
€TIRAS and 145 ... Security Group .
€72 schema Admins  Security Group

CN R Y | I 3

6. Now create a user account in the Users container for Brady Jones with the password
mega from within srv-11’s Active Directory Users and Computers console. This way
you can see how replication will update the Active Directory database on both domain
controllers. Close the Active Directory Users and Computers console when finished.

4 Active Directory Users and Computers
| <5 Console  Window  Help

[ acon wew ||« = [Bm xS 26|26 f TS

Tres | Users 16 objects
Active Directory Users and | |_Mame. [ Type [ Description [
E-Z§ benandbrady.com €7 Administrator  User Built-in sccount For admiri...
B[] Builtin ones
([ computers Security Group ... Enterprise certification an...
(&) Domain Cantroliers | |€Ronsadmins Security Group ... DNS Administratars Group
(1 ForeignsecurityPrin | @ pnstpdatePr...  Security Group .., DNS cents who are permi. .
2 Users TiDomain Admins  Security Group ... Designated administratars...
#800main Comp... Security Group ... All workstations and serve...

7. Replication can be forced from any of the domain controllers in the domain from within
the Active Directory Sites and Services console. Use srv-11 since it is the server you
were last on and go to Start>Programs—>Administrative Tools—> Active Ditrectory
Sites and Services. In the left pane go to Sites>Default-First-Site-Name—>Servers.
There you should see domain controllers, s7»-7 and srv-717.

Teaon wew | & » B@ X & 0B @

Tres | Name | Domain [ Type ]
Active Direciory Sibes and Servies [srv-11 | & 5791 benandbrady. com Setver
- Sites B srv-11 benandbrady. com Server

£+ [ Defauk-First-Site-Name
SRt

B sevnn
(- Inter-Site Transports
(22 Subrets
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8. Now within each server are the NTDS (Active Directory Database) settings. Open
both servers in the left pane so that you can see the NTDS settings.

¥ AD Sites and Services

Jﬁ Console  Window  Help

|| action vew || @ » |E[m|[E DB S
Tree | Hame [ ype | e
Active Directory Sites and Services [srv-11 BPNTDS Settings Damain Controller Settings
=-(0 Sites
E\ Defaulk-First-Site-Mame
| = servers
; EREEE!
[3 NTDS Settings
=3 SRyt
-8 NTDS Settings
[:I Inker-Site Transports
(23 Subnets

9. Select the NTDS settings for stv-1 and you should see the connection to s7»-77 in the
detail pane. Right click on the connection and select Replicate Now. A dialog box will
appear telling you that Active Directory replicated. Now do the same for the connection
to srv-1 within the NTDS settings for srv-11 and close the Active Directory Sites and
Services console when you are finished.

Jﬁ Consale  Window  Help Jﬁ Console  Window  Help
|Jﬁctmn Wizt H@-}llxl@ “ﬁction Wigthl H@-}llx‘@
Tree I Hame From Server Tree I

From Server

Active Directory Sikes and Services [srv-11

Active Directory Sites and Services [srv-1
=0 Sites

=1 Stes

- Default-First-Sice-Name Al Tasks 5 -] DeFaule-First-Site-Hame all Tasks
. B[ servers et —— § B[ servers
; £ sRv-1 Delete =B srv-1 Delete
. [ NTDS Settings Rename [ NTDS Settings Rename
B sRv-11 Refresh (== U Refresh
--[3B NTDS Settings _ .. NTDS Settings e

10. Now on stv-11 open the Active Directory Users and Computers console and try to
find the users accounts for Ben Smith and Brady Jones in the Users container. They
should both appear in the user’s container. Now try to find them on the Active
Directory Users and Computers console on srv-1. If you are able to see both user
accounts on either server, it means that Active Directory replication is working properly.

-:-; Active Directory Users and Computers

J@ Console  Window  Help

Jacon yew ||« » BE xHFRE 2| Bl 7

Tree I Users 17 objects
Active Directary Users and | | Rlame | Type | Description
E@ benandbrady .com Mﬂrator Lser Built-in account fe
[-(23 Builtin €7 Ben Smith User

ﬂ Brady Jones User

blishers Group ...  Enterprise certific
@Dnsndmins Security Group ... DNS Administrato
ﬁEDnsUpdatePr. .. Security Group ... DMS clients wha 2
¢TiDomain Admins  Security Groun ... Desianated admir
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Lab 2

Creating an Organizational Unit (OU)
Structure for Wired Brain Coffee, Inc.

You will learn how to:

e Create and manage Organizational Units (OUs)
e Create and move objects within Organizational Units
e Delegate control of Organizational Units
e Test delegated Organizational Units
e Remove delegated control of an Organizational Unit
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Scenario Part One

You finish the installation of the domain controllers way ahead of schedule and everything is
working great. You report to Jill, the Operations Manager, that the domain is up and
running without any issues. She says, “WOW great job!” She is very impressed, you think
to yourself, “that full time administrator job is all mine.” Jill then asks you if you’re ready for
the next project. She has designed the Organizational Unit (OU) structure that the company
is going to use on the network. She hands the project over to you with all of the necessary
information and asks you to see her after you have implemented and tested the OU
structure.

In this lab you will create an Organizational Unit (OU) structure for Ben & Brady’s Ice
Cream Co. Jill’s design is a “hybrid” approach, based on location first, then on business
functions. You will first create OUs for each location and then create child OUs within
them for each department in the company. You will also create and move objects within the
OU structure. Finally, you will delegate control of some basic administrative functions to a
user located in the North Carolina location.

Organizational Units

Organizational units are new to Windows 2000. OUs are Active Directory containers that
you use to organize objects within a domain. An OU can contain objects like users, groups,
computers, printers, other OUs, and shared folders. OUs can be assigned group policies and
can be used to delegate administrative tasks to users or groups. The key to building an OU
structure is to have a system that is easy to manage and works well for the company. A
company may use different strategies for creating their OU structure. The OU structure can
be based on location, business functions, types of objects, or a hybrid of many different
strategies. This structure will vary from company to company, depending on what the needs
of the individual company are. OUs are a good alternative to creating multiple domains and
Microsoft recommends that your company only have one domain if possible.
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e orecory ]
Lab 2

OU-Structure

Benanndbrady.com

Domain
CA NC
Marketing Accounting Sales Marketing Accounting Sales
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Creating OUs

1. Log on to srv-1as the domain administrator and open the Active Directory Users and
Computers console. Go to Start=>Programs=>Administrative Tools—> Active
Directory Users and Computers.

wows bl

e =» amleE B2l v & o

fbrady com 5 objects

2. On the left pane, right click on benandbrady.com and select New=> Organizational Unit.

o Comole  Yandow ek
bion vew ||+ =+ @@ EFDGE @B

3. A screen will appear asking you to specify a name for the new OU. Type in NC for
North Carolina and click OK. You will now have an OU named NC in the left pane of
the Active Directory Users and Computers console.

4Z Active Directory Users and Computers
[ it Graanational it = | < gonsole  window  Help

“ Action view || &= = [ @E[m]|

Tree |

(25| Cewen bt o

S

prc Active Dirsctory Users and Computers [srv-1

=P benandorady.com
(2 Builkin
(3 Computers
{2] Domain Controllers
(3 ForeignSecurityPrincipals
{1 Users
(e e

- b

4. Create another OU in the benandbrady.com domain for California and name it CA.
You should now have two OUs appear in the left pane of the Active Directory Users and
Computers console. One named NC for the North Carolina location and one named
CA for the California location.

e T

|| acion wew || & = | @=m[m| <

Tree |

Active Directory Users and Computers [srv-1
=29 benandbrady.com
(£ Builkin
(1 Computers
(28] Domain Conkrallers
([ ForsignSecurityPrincipals
3 users
(Al
(=

By
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5. Right click on the NC organizational unit and select New=> Organizational Unit.
Type in Marketing for the name of the new organizational unit and click OK. You
have now created an organizational unit for the marketing department within the NC
(North Carolina) organizational unit.

= Aci = e
Lo D 4% Active Directory Users and Computers
= Sorscle  Windem el -
stkn wew || & = | B | X F D # 1 Console  Window Help
Tree | €A Oohiets |J AdiEn W H & = | | x
Actren Ewectiny ks arad Comgaers [4rv-1 | NBTE
=3 berandbrady,com
SR T Tres I
o [ Comguiers
= (] Domain Cortrobirs @ Ackive Direckory Users and Computers [srv-1
1 jzr’m"m“m E@ benandbrady . com
- | -2 Builtin
MI—:;“:!I:IGHI\... D CDmDUters
M. €3] Domain Controllers
il D FareignSecurityPrincipals
Liegader
Al Tarik L Conkact
N Wiradoms froen Have L
Daetn
Rosruwne User
[ Shared Foldsr

6. Next, create additional organizational units for the Sales and Accounting departments
within the NC (North Carolina) OU. Then create the same three organizational units
for the different departments within the CA (California) organizational unit. Your final
structure should look like the figure below.

and Computers [srv-11 benandbrady.com]

----- (1 Computers
{&] Domain Controllers
(22 ForeignsecurityPrincipals

@[] Accounting
(£ sales
{8 Marketing
=& A
(€] Accounting [}
B-(&] Sales
{8 Marketing

Creating objects within the Organizational Units

1. Create a user account for [i// Smith in the Accounting OU within the CA (California) OU.
Right click on the Accounting OU within the CA (California) OU and select
New—>User.

| Users
B0 N
{2 Accounting
(] Sales
[#-{&2] Marketing

{2 Add members to agroup. ..
Morve.

Find,

0 computer
il Tasks b Contact

Grouy
View 2

Organizational Lnit
New Window from Here

Printer

Delete W
Rename Shared FBider
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2. The new user wizard will appear. Type in the full name of Jill Smith with the user logon
name of jsmith and click Next. Type in test as the password, then click Next. Click
Finish on the last screen.

New Object - User 4| il e Obiject - User x|
g Createin:  benandbrady.com/CA Aecounting g Create i benandbrady. com/CA/Accounting
First hame: |Jm e Password: |n
Last name: |5mim Confim passward: |
Full name: |Jm Srith

™ User must change password at nest lngan
User logon name: ™ User cannot changs password
[femith [ @benandbiady.com =l I Passward never expires

™ Account s disabled

User logon name (pre-Windows 2000}
IEENANDEHADY\ I\srmth %

< Back |J\ Mext > | Cancel < Back | Met > I Cancel
1y

3. You should now have a user account for Jill Smith appear in the details pane on the right
side when you select the Accounting OU within the CA OU.

<% Active Directory Users and Computers

| &5 Console  indow  Help
|J fction iew Hc:- -b|\)<\|§“5'ﬁﬁ§ﬁi‘a|?§h

Tree | Accounting 1 abjects

&5 Active Directory Users and Computers [srv-11 benandbrady com] | | ame [ Tvpe |
2 benandbrady.com € il 5wt User

(&) accounting
Sales

| @1 (&] Marketing
=&l ca

G Accounting
(] Sales
(&) Marketing

4. Now create the following users from within the table below. Make sure that they are
created within the correct OUs.

First Name  Last Name Username Password, ou
Jack Straw jstraw test  [NC->Marketing
Sue Stevens sstevens test  [NC->Sales
Bob Hayes bhayes test [NC->Accounting
Peter Ramirez pramirez test  [NC>Accounting
Maria Perez mperez test  |CA->Marketing
Mark Jones mjones test  |CA->Sales

Christina Sanchez csanchez test  |CA=>Accounting
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Moving Objects between Organizational Units

1. You cannot have two objects with the same username in your domain; regardless of
what organizational unit they are in (technically you caz make this work, but it is not
worth the hassle and is beyond the scope of this lesson). For example, let’s say that the
user Jack Straw is being relocated from the North Carolina location to the California
location. If you try to create a user account for Jack Straw in the Marketing OU
within the CA (California) OU, you will get an error message when you try to advance
to the next screen of the new user wizard. If you followed along, Click OK and then
click Cancel to close the new user wizard.

x

g Create in:  benandbrady.com/CaMarketing

First name [Fack Initiak: |

Last name; |5l|aw
Active Directory x|
The user logon name you have chosen is already in use in this enterprise,
Chaoose another logan name, and then try again.
|BENANDBRADY istraw
¢ Back. | Next > Cancel

2. Instead of deleting and re-creating the user account in the California-Marketing OU,
try moving the user account. Find the user account Jack Straw, which is located in the
North Carolina>Marketing OU. Next, right click on the user account and select
Move.

% Active Directory Users and Computers
| <5 console  window  Help

IR

Tree | Marketing 1 objects
(25 acive Drectory Users s Comy [ Beme————[Tope
-2 benandbrady.com €3
(23 Builin Copy...
----- [ Computers Add members ko & group...
{&] Domain Cantrollers Disable Account
----- % ForeignSecurityPrincipals s P rEho
----- Users
@i open home Page
~{&] Accounting
Send mail
(& sales = @@
(€3] Marketing All Tasks 3
=23 ca ST
(@] Accounting Delete
[&] Sales Rename
«{2] Marketing Refresh
Properties
Help
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3. That will bring up a small explorer window where you can browse through all the
containers that are available within the domain. Open the CA OU select the
Marketing OU, and click OK.

Container to move object to:

i

=+ benandbrady
D Builtin
-] Ca

@ Accounting

Computers

Domain Contrallers

123 ForeignSecurityPrincipals
(& e

-] Users

Cancel

The user account for Jack Straw should no longer appear in the details pane on the
right of the console for the North Carolina=>Marketing OU (see below).

Now open the California=>Marketing OU and you should find the user account for
Jack Straw located in the details pane of the console.

4% Active Directory Users and Computers 4% Active Directory Users and Computers
| <5 consols window  Help 0 Console  findow  Help

|| aetion wew || = -»|\><I|§HJ o wow || & o LW XS DB 380
Marketing O objects Treel

Hame: Type

Tree |
Marketing 2 objects

Active Direckory Users and Comp

E1-Z§ benandbrady.com

(2 Builtin

+(C] Computers

(5] Domain Controllers
(L1 ForeignSecurityPrincipals
{23 Users

() NC

| {23 Accounting

- Sales

[ Accounting
(2] Sales
Marketing

6. Next, you will move the user account for Ben Smith and Brady Jones from the Users
container to the departments they are a part of. Open the Users container and find the

E-F benandbrady.com

Name TEEE

3 Maria Perez  Uiser

Active Directory Users and Comp

(21 Builtin
B{& A
i {21 Accounting

{1 Marketing
o fd) sales
(3 Computers
Domain Contrallers
-] ForsignSecurityPrincipals
() NC
o Users

user accounts for Ben Smith and Brady Jones.

] @ Console

window  Help

tive Directory Users and Computers

“ Action  Miew |J

Tree I

Active Directory Users and Comp
EI@ benandbrady.com
(23 Builkin
D Computers
{€3] Domain Contrallers
I:I FareignSecurityPrincipals
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7. The user account for Ben Smith needs to be placed in the North
Carolina=>Marketing OU and the user account for Brady Jones needs to be placed in
the California=>Marketing OU.

-.? Active Directory Users and Computers {énctive Directory Users and Computers

J@ Console  Window  Help | <5 Console  Window  Help

|J acton wew || & = [E@| X @] 2 | acton vew || & & | @@ | X 5 BB |

Tree I Marketing 1 objects Tree I Marketing 3 objects

@ fictive Direckory Users and Comp |Mame | Type @ Active Direckory Users and Camp M"“E—I_TZL

E=-Z§ benandbrady ,com L fEen Smith  User =23 benandbrady.com €3 Maria Perez  User
-2 Builkin D Builkin Jack Straw  User
- ca =& ca | sqbrady Jones User

B[] Computers
@ Damain Contrallers
[:I FareignSecurityPrincipals %

E-{&] MC

#-[_7] Computers

@ Accounting - @ Domain Controllers
@ Marketing [:I ForeignSecurityPrincipals
(&3] Sales @ MC

D Users

Scenario — Part Two

You have completed the initial work on the OU structure. When you check in with Jill, she
is very happy with your progress. “The job is completed and way ahead of schedule too.
How would you like to be the full time Network Administrator?” Jill asks you. You know
that you should probably get back to her so you can think it over more, but you can’t
contain yourself. “I’ll take it!” you blurt out.

You have been a network administrator at Ben & Brady’s Ice Cream Corp., for six months
now and have been bombarded with lots of projects to work on. The worst part is that the
Jr. Network Administrator at the North Carolina location resigned about a month ago and
the company still hasn’t found a replacement. You have been extremely busy trying to
handle problems at both locations. It wouldn’t be so bad if you didn’t have to deal with all
of the little problems that always come up, like resetting passwords and managing
user/group accounts. To provide some relief until the North Carolina people hire someone,
you have decided to give the user Peter Ramirez, who is a manager in the accounting
department, control over creating, deleting, and managing user accounts and groups in the
NC OU. You chose him because he is tech savvy, familiar with all of the departments in
the North Carolina location, and many users already go to him when they need help. Peter
is more than happy to take on the added responsibility.
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Delegating Control

By using Organizational Units (OUs), you can delegate control of tasks for an OU to a
particular user or group that may not have any administrative privileges to perform these
tasks. That user or group can then administer the tasks and on/y those tasks that were
delegated to them. For example if a user in accounting is delegated control of resetting
passwords for the Accounting OU in California, they will only be able to reset passwords for

that OU. If the user tried to reset a password anywhere else in the domain they will be
denied.

1. On the Active Directory Users and Computers console, right click on the NC OU and
select Delegate Control.

£ Active Directory Users and Compul

| <5 console  Window  Help

[ sam v | & @)
Treel =
&5 Active Directory Users and Cop, | amt

=) @ benandbrady.com (<5
(21 Builtin .
@
(2 Computers
[ Domain Contrallers
(22 ForeignSecurityPrincipals

[GRFETYC

Add members to a group...
Maove...
Find...

2. 'This will start the delegation of control wizard. The first screen is just a welcome screen,
click Next. On the next screen you will have to select the users or groups that you want
to delegate control to. Click on Add and you will have another screen appear showing

you a list of the users and groups that are available on the domain. Find and select the
user Peter Ramirez click Add then OK.

[ Delegation of Control Wizard

Usess o Growps

Selesct one or mone UTeIs O IOUDY o whom pou wank 10 delegate control al
Selacted usess and groups
|
=zl
| meEen|
Cocn_| gl CET
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3. You should now have the user named Peter Ramirez appear as the selected user that you
want to delegate control to. Click Next.

o

4. The next screen will show you some of the possible tasks that can be delegated to this
user. Microsoft selected six of the most common tasks that administrators may want to
delegate. If none of these tasks are what you want, you can also choose to create a
custom task to delegate. Creating a custom task to delegate is a lot more complex,
especially if you are not very familiar with Active Directory security. Use the tasks that
are supplied by Microsoft until you become a Windows 2000 expert or have excellent
documentation to guide you. Select the first four common tasks that are supplied,
which will give Peter Ramirez all of the control he needs without giving him too much
control and then click Next. The final screen of the wizard will give you a summary of
the selections you made. Confirm that all of the information is correct and click Finish.

Delegation of Control Wizard x|
Tasks to Delegate
You can select commaon tasks ar customize paur owin,

¢ Delegate the following comman tasks:

Create, delete, and manage user accounts
8t passwords on user accounts
ead all user information

Create, delete and manage groups
[ todify the membership of a group
[ t4anage Group Policy links

£~ [Cieate a custom task o delegate

< Back I Mext > I Cancel

Testing the delegated permissions

In order for the user to access the Active Directory Users and Computers console, you
will need to remotely configure his computer (the Windows 2000 Professional machine at
his desk) to make him a local administrator. This will give him administrative privileges to
his local computer only, not the domain. The user will then be able to install the
adminpak.msi file that is located on the 1386 folder of the Windows 2000 Server CD-
ROM. The adminpak.msi file will install the administrative tools for the domain on the
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computer because Windows 2000 Professional does not include the Active Directory
administrative tools. You will then need to create a management console for Active
Directory Users and Computers so that the user can easily access the tools he will need
without giving him access to all the administrative tools. Then you will have to create a
share for this user to be able to access the files he needs over the network.

1. Log on to srv-11 as the domain administrator. Now create a management console to

connect to client-1’s local users and groups snap-in tool. Go to Start=>Run, in the
command prompt type in mmc and click OK.

R X

Type the name of a program, folder, dacument, or
Internet resource, and Windows will open it For you,

Open: I o] j

OK I Cancel | Browse. .. |

2. That will bring up an empty management console. On the top menu select
Console->Add/Remove Snap-in.

"Hi Console1

|| gorsole window beb || D) 5 I |
g Hew kN
Open... Chrl+0

Save Chrl4+5 ‘ IQ

Save As...

Add] ... Chrl+M
Option:

1 CH\WINNT\System32|dsa

2 CAWINNTYSystem32\dssite

Exit

3. That will bring up another empty screen, which is where you add the snap-in tools that

you want to use. Click on Add to bring up a list of available tools that can be added.
Select Local Users and Groups then click Add-> Close.

R * 44 Stond ke SoRe 1z
Standsbore | Extenionn | Ayadable Standsone Snagring:
. - Srpin | Wende [=]
. _ ¥ nipinel Aushertication Service [IAS)  Microasit Comporation
Snaprrn ackledis. [ Conacia Roct = B 11 Secuey Beiey Morwgemens
Lk Lo Wieb Auddiess
Micratah Corperstion
5] Pesicemance Logs and Stz Microsodt Coporstion
EY, 0 Avkrmssnon Corbol Moot Conponslion
87 Remavabie Stoesas Mansatrnent Highiound Systens, Inc.
(T Riuding and Rinmale Arcess Microsodt Coporstion
5 Sty Condipastion vl fnsbyss Micausolt Conpnsiont
[ Secuty Templaer Microssht Comporstion. ]
Descicicn Descrition
Mariages Local Users and Gious
e | s '
- Clo
= = i fadd | ie
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4. You will be asked to select the computer you want to manage with this snap-in tool. By
default, it will have the local computer you are on selected, but you want to manage the
computer client-1. Select the option for Another computer then Browse the
benanbrady.com domain for client-1 or simply type in client-1 and click Finish.

Choose Target Machine x|
Select the computer you want tis Shap-in to manage.

This snapin will slways manage

" Local computer. (the computer on which this console iz running)

& Another computer | ENEE] Browss. |

I~ Allaw the selected computer to be changed when launching fram the command ine. This

orly applies if you save the console

<Back | [ Finish Cancel

5. This will bring you back to the management console within the local users and groups
snap-in tool for client-1. You want to add the domain username pramirez to client-1’s
local Administrators group. In the left pane open the Groups folder, then in the
details pane, right click on the Administrators group and select Add to Group.

"fii Console1 - [Console Root'Local Users and Groups (CLIENT-1)\Groups]

%8 console window  Help

J fction  Wew  Eavorites |J = = | | > | %)

Tree IFavorites |

Deescription

Backup Operators @
] Gests

g Al Tasks 3

[_1 Consale Root
E& Local Users and Groups (CLIENT-1)
0 Users

{425 Groups

Delete
Rename

Properties

Help

6. That will bring up a screen with a list of the members in the group. Click on the Add
button and it will open up a new screen with a list of users and groups available in the
benandbrady.com domain. Find the user Peter Ramirez then Add the user and click
OK. That will bring you back to the list of members in this local administrators group.
Look to make sute that the uset BENANDBRADY \ pramirez appears on the list and
click OK.

st ot Prowerties 20

Gameesd |

g Admiriatraion

Deserigtion: [t and unemstiictad accn: b S compan/doman

Members:

Emaneiraton
BEMANDERAL e Advar:

# EE AN
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7. The user Peter Ramirez is now a member of the local administrators group for the
computer client-1 only. He will not have any administrator privileges for the domain or
any other computer in the domain, except for client-1. Now close the management
console without saving it. This is not a tool you will be using very often and it’s easily
accessible if it’s ever needed again.

8. Now open the C: drive, using Windows explorer and create a new folder named
Management Console to place the files the user will need. Right click on an empty space,
select New=>Folder and name the folder Management Console.

S (2 (@ (3

Documents  Program Files WINNT

Local Disk (C:) and Settings

Select an item to view its
description,

9. Next, insert the Windows 2000 Server CD-ROM and copy the ADMINPAK.msi file

located in the 1386 folder to the folder you just created named Management Console
on the C: Drive.

A
Manahgement

Console

10. Now you need to create a management console with the Active Directory users and
computers snap-in tool and save it in the management console folder. This will make it
casier for the user to manage the OU and it will keep all the other administrative snap-in
tools out of site. Go to Start>Run=>type mmc in the command prompt and click
OK. This will open an empty console. On the menu select Console>Add/Remove
Snap-in. On the next screen click Add to see a list of available snap-in tools. Select
Active Directory Users and Computers then click Add-> Close.

Add Standalone Snap-in d B

Available Standalone Snapins:

[ endor =
Microsoft Corporation
Micrasaft Carporation
MR Microsolt Carporation

aprin
Active Ditectory Domains and Trusts

D

Active Directory Users and Computers allons: management of users,
groups, arganizational urits, and all ather Active Directary abjects.

Add Close
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11. Then, click OK on the next screen and you should have the Active Directory Users
and Computers snap-in tool appear in the management console.
"Hi Consolel

J Console  Window  Help |J 0= |

:m Console Root' Active Directory Users and Computers [sr¥-11.benandbra

J Action  Wiew  Favotites |J & = || ‘@ J;'ﬁﬁi@v@“ﬁm
Tree IFavnntEs | Marmne | Tvpe | Description |
I_ Console Raot [ZdBuitin builtinDomain

E @ Ackive Direchory Users anc C'Q
BBk benandbrady. com (computers Container
[ZDomain Cortr... Organizational ...
DFDreignSacur\. .. Container

Organizational ...

Default container For upgr...
Default container For new ...
Default container For secu...

MC COrganizational ...
% (Cdusers Caonkainer Default container For upgr. ..

12. Before saving the management console, make sure to set the options on the console so
that it is set to user mode. This way the user will not be able to add or remove any other
snap-in tools to this console. From the top menu select Console=>Options. Change
the Console mode option to User-mode — full access. This will allow the user to have
access to all the management commands, but will prevent the user from adding or
removing any snap-in tools and keep him from changing the console properties. Click

. CEO————— x
iti AD Console HE
Conacln |
) ,,
J Console  Window  Help |J = i —
@ Mew Chrl+r
I Qpen. .. Chrl+C
[ EE Clrl+S oo T -
Save As.. Deseripton
[ Add{Remaove Snap-in... Chrl+ ki1 o1 chinging Coneclo pIOR. ] 2
1 AD Consale
2 CAWINNTYSyskem 32 dsa L
™ Do et siwe changes i thit consols
3 CAWINMTYSyskem32 dssite % Alkom the ures b cstomize views
Exit I

13. Now save the console with the name AD Console in the Management Console folder
on the C: drive. Close the console and open the C: drive to confirm that the file was

saved.
HJ, 4
5 A0 Consale
Management
Console
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Now you will need to share the folder so that the user will be able to access the folder
from his computer. On the C: drive, right click on the Management Console folder
and select Sharing. Select the Share this folder option, leave the default share name
Management Console and click OK. Now close windows explorer and log off the
server.

21

Gormral Shaing | Secusty |

- chars this fokdee it
R,J Dabrof. To enatle harm o 1 ok cick Shur ¥ie

1 Dok shun s Bokded
1% Shain Bus bolder

Shoun rames.[VManagemen Conscle
Comment:
Uk Mo slowed

C [ s

To el paerasaons bor hwe avers acomss Pemiss
fokder cvee the etwork, ek Pemizcaing. &Es

T conhigue setings for Ofine sccessto
o i oo |

[ ] oo | b |

Now you will need to share the folder so that the user will be able to access the folder
Log on to client-1 with the username pramirez, you will pretend to be the user, install
ADMINPAK.msi onto his computer and copy the AD Console over to the desktop.
Open the shared folder by using the UNC (Universal Naming Convention) path in the
run command prompt. Go to Start=>Run and type in \ \stv-11\Management
Console then click OK. The UNC path is | | Computer Name\Share Name, which
in this case is \ \stv-11\Management Console.

Management

Type the name of a program, folder, document, or
Internet resource, and Windows will open it For you,

Open: I Yisrv-11{Management Console j

[8]4 I Cancel | Browse. .. |

Page 50 of 85 © Train Signal, Inc., 2002



16. This will directly open the shared folder, Management Console on srv-11. Copy the
AD Console over to the desktop and then open the adminpak.msi file to install the
administrator tools on to the Windows 2000 Professional computer.

& Management Console on srv-11

| Fle Edb View Favortes Tools Help
| ra - = - my | Dimearch ChFolders (HHstory | Y 05 ¢ |
| dess [ management Cansale

= [

= il B 8
=l 4D Console sy
Management Repair

Console Uninstal

Make: fvailable OFfline:

ine.
& This folder is Online, Open With,..

17. When the installation of the administrator tools is finished, close the Management
Console folder and open the AD Console located on the desktop. It should open up to
the Active Directory Users and Computers snap-in tool.
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18. Now, to test if the delegation worked, try to create a new user in the North Carolina OU.
Right click on the NC OU and select New. Notice that you only have two options to
choose from under new, they are Group and User. Select User, to open the new user
wizard and create a user named Delegation Test, username dtest and a password test.
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19. When you finish the new user wizard, you should see the new user you created in the
NC-O0U.

'Hi Console Root' Active Directory Users and Computers [sryv-11.bei
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20. Now try to create a new user for the California OU. Right click on the CA OU. Notice
that there is no New option available on the shortcut menu because this user was only
given permission to mange the NC OU and therefore, cannot create any new users or
groups in the CA OU. Although there are other options still available, the user will get
an error message stating that access is denied if they try to use any other option. Close
the AD Tools console and log off client-1.
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Scenario — Part Three

Finally, your relief has arrived! Ben & Brady’s Ice Cream Corp., has hired a Jr. Network
Administrator for the North Carolina office. Although Peter Ramirez has done a great job
helping you out in North Carolina, you want the Jr. Network Administrator to be the only
person with permissions to manager users. Therefore, you will have to remove the delegated
permissions that were assigned on the North Carolina OU.

Page 52 of 85 © Train Signal, Inc., 2002



alrainsiIGNAL. ..

Removing the delegated permissions

Removing the delegated control is slightly more difficult than delegating the controls
because there is no wizard that will “un-delegate” permissions. The only way to remove any
delegated permissions is to go to the security tab of the container and remove the
permissions that were granted through the delegation wizard. This can be a touch complex
for anyone not familiar with Windows 2000. Another point to keep in mind, is that you
should always document any permissions that are delegated. It will make it easier on you
and anyone who may come in after you when trying to figure out who has permission to do
what in the domain.

1. Log on to stv-1 as the domain administrator and open the Active Directory Users and
Computers console. The first thing you need to do is change the view of the console to
adpanced features so that you can access the security tab for the containers. Tty to open
the security tab in the properties of the North Carolina OU without changing the view
first to see what it shows. Right click on the NC OU and select Properties. Notice
that there is no security tab available. Close the properties page by clicking Cancel and
on the menu select View—>Advanced Features.
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2. Now go ahead and open the Properties for the NC OU again. You will see there is now
a security tab available. Select the Security tab and find the name for the user Peter
Ramirez in the security list. Notice that all the permissions for the user are blank. It
doesn’t mean that the user has no permissions for this OU though. If you look at the
bottom of the screen, next to the advanced button, you will see that the user has
additional permissions set.
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Click on the Advanced button to view the advanced permissions. You should see that

there are four permissions for the user Peter Ramirez. You can either remove specific
permissions from the user or remove them all. You can also add specific permissions
that may not have been included on the wizard from here. If you plan on removing all
the permissions from the user, then you would be better off just removing the user from
the security list on the security tab. Click Cancel to return to the security tab.
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4. Select the user Peter Ramirez in the security list, click the Remove button and the user
will now disappear from the security list. Click OK to close the properties page.
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5. Now log on to client-1 with the username pramirez. Open the console AD Tools
located on the desktop and try to create a new user or group for the NC-OU. Notice
how the New option on the shortcut menu is no longer available.

*kk N g te*k*

If the New option is still appearing on the menu it may be that the domain controllers have not
replicated and therefore, the user still has permissions to the OU. You can wait a few minutes for
them to replicate or you can log on to one of the domain controllers to force replication. Either way,
you will have to log off and log back on to client-1 for the changes to take place.

i AL Consol e - [Comele oot Adtive Director
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LLab 3

Creating and Assigning Group Policies for
Ben & Brady’s Ice Cream, Corp.

You will learn how to:

e (reate a Group Policy
e Assign a Group Policy Object (GPO) to a domain
e Assign a Group Policy Object (GPO) to an OU
e Testa Group Policy from a client computer
e Remove a Group Policy Object
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Scenario — Part One

Up until now, users in both offices of Ben & Brady’s Ice Cream, Corp. have been able to
change their display settings and install their own screen savers and backgrounds. But in
your weekly meeting with Jill, the Operations Manager, she feels that there are some users
who have taken it to far by either placing inappropriate pictures on their screens or spending
way too much time installing and looking for new screen savers to install on their systems.

In some cases, they have even damaged their computers by changing the display settings.
“How can we stop users from accessing parts of the operating system that they shouldn’t
access?” Jill asks. “Group Policy is the easiest way,” you respond, “and we won’t have to
police the users either. It just works!” After discussing the matter in great detail, you and Jill
reach the conclusion that there is really no reason that the users of the domain need to
access the control panel either. You decide to create a group policy on the domain to
restrict all users (except the administrators) from the control panel. You also decide to
disable the My Network Places icon on the desktop to keep the users from browsing the
network and instead, just allowing them to use their mapped network drives that are pre-
assigned.

Jill agrees to all of your propositions but reminds you that marketing department in both
locations will need to access their display settings because of a custom piece of software that
requires them to adjust their screen resolution. This means that the group policy you
discussed previously will not be enforced on users in the marketing department.

In this lab, you will create group policies, configure policy settings, and link them to the
domain and an OU. You will also see how one group policy can override another group
policy based on where in the Active Directory it is linked. Finally, you will see difference
between removing a group policy from a container and deleting a group policy from Active
Directory.

Group Policies

Group policy is a new feature in Windows 2000 that allows the administrator to set user and
computer configurations across the network in an efficient manner. Some of the settings
that can be specified include scripts, security, folder redirection, software installations, and
registry-based options. Group policies are similar to system policies used in N'T 4, except
that group policies are easier to work with. Group policy settings that you create are stored
in a GPO (Group Policy Object) and are replicated to other domain controllers via Active
Directory. With NT 4.0 system policies, you have to make sure that the file, which contains
the settings, is replicated to all domain controllers in the domain and whenever you delete
that system policy you have to remove the setting from every computer that it was applied
to. The Group Policy Object (GPO) is assigned to an Active Directory container (Sites,
Ous, or Domains) and the settings are then applied to all user and computer objects that
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reside within the container. Any group policy setting that is removed does not need to be
changed in the registry on each computer. It is automatically removed from each system.
There are two general types of group policies in Windows 2000, local policies and domain-
based policies. A local based policy will just apply to a local computer or a local user on the
computer. A domain-based policy works with Active Directory and is applied to computers
or users in the domain.

Sales

Active Directory |

Lab 3

Group Policies

Benanndbrady.com
Domain

£
GPO

Deny-Control
Panel

Marketing §
GPO
Allow-Control
Panel

Accounting

Marketing

Accounting  Sales
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Creating & assign a group policy to the domain

Log on to srv-1 as the domain administrator and open the Active Directory Users and
Computers console. Right click on the domain benandbrady.com and select
Properties. On the properties page select the Group Policy tab to view a list of GPO’s
that are linked to the domain. By default, you will see the Default Domain Policy on the
list. This GPO will have some basic settings in place, but in order to lock down client
computers you will have to create additional settings within this GPO or another GPO
that is linked to the domain.
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Click on the New button to create a new GPO. Name the GPO, Hide My Network
Places. Highlight the new GPO and select the Edit button. This will open the group
policy snap-in tool. From here, you can see the two different types of settings. The first
one is the computer configuration settings that are applied to the computers when they
start up and the second one is the user configuration settings that are applied to users
when they logon.

®EkN gte®+*

In this lab we will create one Group Policy Object (GPO) for every policy setting, so that you can see
how each GPO works. It does not mean that you are limited to just one policy setting for every
GPO. You can configure as many policies as you want in a GPO, but you must have a plan on how
you will be implementing group policies on the network, so that you know what policy settings can
be placed in the same GPO and what policy settings require a separate GPO.
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3. You want to create a GPO that will hide the My Network Places icon from the
desktop and apply it to users on the entire domain. You also don’t want it to affect any
of the administrators. On the left pane select Administrative Templates under User
Configuration. Under the administrative template folder, select the Desktop folder
and you will see all of the available settings on the right pane. You should also see that
all of the settings on a new GPO are not configured by default. In order to enable the
policy find the policy setting that says Hide My Network Places icon on desktop and
double click on it.
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4. 'This will open the properties of that setting and show you the options available on it.
There are three options. The default option that is selected is not configured. There are
also options to enable or to disable the policy. Select the Enable option. For every
setting, you also have a tab called Explain. Select the Explain tab and you can read what
affect this setting will have if it is enabled or disabled. Go back to the Policy tab and
make sure the setting is Enabled and click OK.
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5. This will bring you back to the Group Policy snap-in tool. Now if you look at the Hide
My Network Places icon on desktop setting you will see that it shows that it is
enabled. Close the Group Policy snap-in tool.
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6. 'This will bring you back to the Group Policy tab for the benandbrady.com domain.
Highlight the Hide My Network Places GPO and click on the Properties button. On
the properties page of the GPO you will see a summary of the GPO. It shows the date
and time it was created and the last time it was modified. Then you will see how many
revisions have been made to the GPO. This just tells you how many settings have been
changed since the GPO was created. In this case, there one was done for the user
configuration. Underneath the summary are options to disable unused parts of the
GPO. For example in this GPO, since only a user setting has been enabled, selecting the
Disable Computer Configuration settings will speed up the computer start-up and
logon time.

Hide My Network Places Properties: x|
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§ Hide My Metwork Places [srv-1.benandbrady.com]

Created 9/10/2002 1:31:49 FM
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 Disabl
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Ly
’D—KI Cancel | Apply

7. Select the Links tab. This is where you can do a search to see what containers on the
domain have this GPO linked to them as well. Select benandbrady.com domain and
click on Find Now. The search should only find the benandbrady.com domain.

Hide My Network Places Properties 2ixl

General Links | Securty |

Search for Sites. Domains and OU's that use this Group Policy
Object. Click the Find Now button ta start the search. This might
take several minutes to complete.
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Sites, Domains or Drganizational Units found:

OK. I Cancel Epply
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8. Select the Security tab. This is where you assign permissions to users or groups for the
Active Directory object that you are working on. You set permissions on an Active
Directory object in a similar fashion to files and folders. Permissions on an Active
Directory object determine what a user or group can “do” to that object (i.e. see it,
change it, delete it, etc.). In this case, you do not want this policy to apply to any
administrator on the domain. So, find the Domain Admins group and the Enterprise
Admins group, and select Deny for the Apply Group Policy option. This will apply
the GPO to all authenticated users on the domain except for the users in the Domain
Admins group and the Enterprise Admins group. Click OK, you will get a warning
message about setting Deny permissions because the deny permission always take
priority over any Allow permissions. Click on Yes, that you wish to continue and click
OK until you get back to the Active Directory Users and Computers snap-in tool.

2%

Garwesl | Lrks  Secusty |

[y Add
5 musneniicshed Usess
I CREATOR OWNER H—I
. =
L& i Ak | " e A
0 svsTEm
Pesmittions: ) By
il Control o [m]
Pead =) o
wte o
Cimabe A Chad Clbycts B o
Drelet Al Chid Obiscts =] o
o —— =] %
1
| Aukblonal pirmiacrs: s et bul ol
| |

9. Now, Create a new domain GPO that will disable the Control panel for all users except
for administrators. Right click on the benandbrady.com domain and select Properties.
Go to the Group Policy tab and click on New.

10. Name the new GPO Deny-Control Panel, then click on Edit to open the group policy
snap-in tool for the GPO. On the snap-in tool, select Administrative Templates
under User Configuration. On the right pane double click on the Disable Control
Panel setting to open the properties and select Enable on the properties page. Click
OK and you should see that the setting is now enabled.
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11. Close the snap-in tool and open the Deny-Control Panel GPO Properties. Select the
Security tab and make sure the GPO does not apply to any adwinistrators by following
the same procedures you followed in step 8 above. Click OK and the benandbrady.com
domain should now have three GPO’s assigned to it.

Jlcr oy o reaperties 2l
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Create & assign a group policy to Organizational Units

Next, you must allow the users in the Marketing Department access to the control panel so
they are able to change the display settings on their desktop. This is necessary because the
Marketing Department runs a piece of software that works best at lower resolutions. Instead
of editing the security list for the GPO, you should create a GPO that will apply only to the
Marketing OU, which contains all of the users in the Marketing Department. This can be
done by creating and assigning the GPO at the OU level so that it overrides the GPO set at
the domain level. The order in which the policies are applied is:

local2site>domain=> OU—>child OU

In other words, any OU policy will override a domain policy, a domain policy will override a
site policy, and a site policy will override a local policy. Keep in mind that this order of
precedence only applies to contradicting policy settings. For example, a policy to install
software that is applied at the site level will not be overridden by a policy at the OU level to
determine the background color of the desktop. But, if you set a policy for a green desktop
background at the site level and set a policy for a blue desktop background at the OU level,
users or computers within the OU will receive the blue desktop background.

1. Within the Active Directory Users and Computers console, find the Marketing OU
located within the CA (California) OU. Right click on the OU, select Properties and
on the properties page select the Group Policy tab.
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Click on New to create a new GPO that will be assigned to this OU and name the new

Highlight the new GPO and click Edit to open the policy

settings snap-in tool. Open the Control Panel settings, which are located under User
Configuration and Administrative Templates. Find the setting Disable Control
Panel in the right pane and double click on it. On the setting properties select the

You should now see that the Disable Control Panel

2.
GPO Allow-Control Panel.
Disable option and click OK.
setting show that it is Disabled.

You must carefully read what the policy setting does, before configuring it, because some of the
policy settings can sound confusing and you may have to read it twice. For example you just disabled
the disable control panel setting. Do you know exactly what this will accomplish? By configuring

this setting to disable, it will allow all

users with this GPO to access the control panel. When you

enabled this setting on the GPO at the domain level you enabled it so that all domain users will not

be able to access the control panel.
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3. Close the Group Policy snap-in tool and make sure the Allow-Control Panel GPO

appears on GPO links list, then click OK.
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Cancel Sl
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Now you will need to add the same policy to the North Carolina = Marketing OU.
Open the Active Directory Users and Computers console, find the Marketing OU
located within the NC (North Carolina) OU. Right click on the OU, select Properties
and on the properties page select the Group Policy tab. This time instead of creating a
new GPO for the same policy setting, you will use the same GPO that you created for
the California = Marketing OU. To link the GPO that you created previously to this
OU, click on Add. This will bring up a list of GPO’s that are stored within Active
Directory. You can search for a GPO by domain, OU, or site. The last tab, All, will
show you all of the domains within Active Directory and is generally the easiest to work
with. Select the All tab. Then select the Allow-Control Panel GPO and click OK.
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You should now see the Allow-Control Panel GPO appears on the group policy links
list for the North Carolina-Marketing OU. Anytime there is a change made to the
Allow-Control Panel GPO it will now affect both OU’s. This makes it easier to
manage the GPO from just one location and then have the policy settings apply to all of
the containers that are linked to it. Click OK and close the Active Directory Users and
Computers snap-in tool.

General | Managed By Group Palicy |

& Current Group Policy Dbiject Links for NC

Mo Overide | Dieabled

Group Policy Obiects highet in the list hawe the highest priority.
This list obtained from: srv-1 benandbrady. com

Wew | s | Ew | e

Oplions... | Delete.. | Propetes | Down_|

I” Block Policy inheritance

0k o] cancel | ooy |

Page 64 of 85 © Train Signal, Inc., 2002



alrainsiIGNAL. ..

Test the GPO’s from a client

1. Log on to client-1 as the user Jill Smith (jsmith). Remember that this user works in
the accounting department in California. Therefore, she is a member of the Accounting
OU located within the California OU (CA) and should not have access to the My
Network Places icon, the control panel or the display settings from the desktop.

1 |Can the User view My Network Places icon on the desktop? X
2 |Can the user access the control panel from the start menu? X
3 |Can the user access the display settings from the desktop? X

2. On the desktop, look for the My Network Places icon. If you cannot see it on the
desktop then the Hide My Network Places GPO is working.

3. Now look in the Start menu to see if the Control Panel is available. Go to

Start->Settings. If you do not have the Control Panel option available then the Deny-
Control Panel GPO is working.

4. Now try to access the display setting by right clicking on any free space on the desktop
and selecting Properties. You should get an error message appear saying that the
operation has been cancelled due to restriction on the computer which means that the
Deny-Control Panel GPO is working. Click OK.

Active Deskiop

Arrange Trons
Line Up Icons
Refresh

Paste,
Paste Shorbeut

M This operation has been cancelled due ta restrickions in effect on this computer, Please contack your system
Hew » administratar,
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5. Log off the user Jill Smith (jsmith) and log back on with the user Jack Straw (jstraw).
Remember the user Jack Straw works in the marketing department in California.
Therefore he is a member of the Marketing OU located within the California OU
(CA) and should not have access to the My Network Places icon but he should have
access to the control panel and the display settings from the desktop.

1 |Can the User view My Network Places on the desktop? X
2 |Can the user access the control panel from the start menu? X
3 |Can the user access the display settings from the desktop? X

6. Repeat steps 2, 3, and 4. You should get the same results for szp 2 but not for steps 3 and
4. You should be able to access the control panel from the start menu and the display
settings from the desktop.

2=l

FOK -

ﬂ% Windows Update

@ P, Netwark and Diakup Connections
e Printers Displey
P Diedindt Morsder on ATI Tochrokages ke 30 RAGE PRO AGP 24
a Taskbar & Start Menu... . R
=] | | e — M
o]
. ua R = 1024 by 758 pels
Tiendiethonl Advancod
P Cancel
Step2 >/ dstar Step3—> e

7. Test the group policy settings with the User Ben Smith (bsmith) who is located in the
Marketing OU within the North Carolina OU (NC). This user should have the same
policy settings as the user Jack Straw (jstraw) from the Marketing OU in California.

8. Log off the user Jack Straw (jstraw) and log back on as the domain administrator.
Repeat steps 2, 3 and 4. You should be able to access everything because none of the
GPO’s applies to any of the administrators.

1 |Can the User view My Network Places on the desktop? X
2 |Can the user access the control panel from the start menu? X
3 |Can the user access the display settings from the desktop? X
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Scenario — Part Two

Jill is now asking you to restrict the marketing users on the domain from using the control
panel as well because the software that required them to change the display settings in the
first place has been upgraded. The new version does not require the display settings to be
changed and again, some users have been taking advantage by placing non-work related
backgrounds and screen savers on their desktops. She also tells you to place the My
Network Places icon back on the desktop because she has had too many complaints from
the users about not being able to browse the network.

Removing a GPO

1. Log on to srv-1 as the domain administrator and open the Active Directory Users and
Computers console. Find the Marketing OU located within the CA OU. Right click
on the OU, select Properties and then select the Group Policy tab. On the group
policy tab find and select the Allow-Control Panel GPO link then click on Delete.

[rancketmg Properties 21

Gonmal| Managedby Grou Pokcy |

ﬁ Cureert Gironay Pokcy Olwsct Links bor Hasksting

Groug Polcy Qbsct Linky Mo Dvemde | Dissbled

Group Polcy Oéjects hiher i :
Thas bl cbawrd hom: siv-1 benandbady com

Wew | am. | Ex | |
Optiont... |an.. | _Propesies | |

I Baock Py mhentance

o ) omen | oo |

2. This will bring up a screen asking you whether you want to remove the link from this
OU or if you want to remove the link and the GPO permanently. By removing the link,
the GPO will still exist in Active Directory and will still apply to the North Carolina-
Marketing OU. The GPO will still be available to use on other containers on the
network. By removing the link and deleting the GPO permanently, it will no longer
apply to the North Carolina-Marketing OU and it will no longer exist in Active Directory
to use again. Select Remove the link, delete the Group Policy Object permanently, and
click OK. You will then get a warning asking you if you’re sure you want to permanently
delete the GPO. Click Yes.

@ Whiat would you lke to do with “Allow-Contral Panel? Delete Group Policy Object ll
© Remave the link from the list & Are you sure you wish to permanently delete Allow-Control Panel?
& Remave the link and delete the Group Policy Object
[%permanenlly
k w |
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1. This will bring you back to the Group Policy tab for the Marketing OU in California.
Click on Add and select the All tab on the GPO list. Notice that the Allow-Control
Panel GPO is no longer on the list of available GPO’s for benandbrady.com.

Add a Group Policy Dbject Link _'?IZI
Domains/DUsI Sites Al |
Look in: Ii benandbrady. corm
All Group Policy Objects stored in thiz domain:
Mame |

ﬁs Default Domain Controllers Policy

ﬁ Default Domain Policy

ﬁ Deny-Control Panel

ﬁ Hidz My Metwork Places

ﬁs Mew Group Policy Object

Iy
Cancel

2.

Click on Cancel and OK to return to the Active Directory Users and Computers
console. Open the benandbrady.com domain Properties and select the Group Policy

tab. On the group policy tab find and select the Hide My Network Places GPO link
then click on Delete.

4% Active Directory Users and Compute[iibenandbrady.com Properties 21
| &5 Console  window  Help Gieneral | Managed By Group Policy |
“ action  View “ & = | | ] & (Gl B (il @l et s s e vy
[Warket
< and Comp | isme | Group Policy Object Links |_No Overide |_Disabled |
T € Brac gEDefaun Damain Policy
work Places
| D Gtk @Dew Eunlml Fanel
E Find...

Connect o Domain. ..
Connect to Domain Contraller...
Operations Masters, ..

¢ Group Policy Objects higher in the list have the highest priority.
F o HMew 3 This list obtained from: srv-1.benandbrady, com
: 3
E A vedls New | add. | mi | up |
¢ Mew Window from Here Dptions.. | Dekie.. [ Propeties | Down |
Refresh
I Block Policy inhiitance
Help by | 0F | ceneal | swi |

3. That will bring up a screen asking you whether you want to remove the link from this

OU to the GPO or if you want to remove the link and the GPO permanently. Select
Remove this link from the list and click OK.

21

@ ‘what would you lke ta do with "Hide My Network Places''?

(% Remave the link from the list

Remave the link and delete the Group Policy Object
permanently

Cancel |
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4. On the group policy tab for the benandbrady.com domain, you will see that the GPO
Hide My Network Places no longer appears on the GPO links list. Click on Add and
select the All tab, on the GPO list. Here, notice that the Hide My Network Places
GPO does still appear on the list of available GPO’s for benandbrady.com and can be

used in other Active Directory containers for the domain.

Add a Group Policy Dbject Link 2lx

Domains/0Us | Sites A1 |

EICT: =E

All Group Policy Objects stared in this domain:

Look in: I@ benandbrady. com

Narne
ﬁi Default Domain Controllers Policy
ﬁi Default Domain Palicy

ﬁi Dery-Contral Panel
56 Hidle M, |aces
ﬁi Mew Group Policy Object k

Cancel |
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L.ab 4

Administrating resources within
Ben & Brady’s Active Directory

You will learn how to:

e Create and publish a shared folder
e Add, share and publish a network printer
e Create a contact in Active Directory
e Perform Active Directory searches for published resources
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Scenario Part One

Everything seems to be working out pretty good for you at Ben & Brady’s Ice Cream Corp.
All of your major projects are done and you finally have time to kick back and take it easy
for once. For your next project, Jill wants you to work on optimizing Active Directory so
the users will be able to search through it more efficiently.

In this lab you will create and publish shared folders, printers, and contacts in Active
Directory. Then, you will log on to the client computer as regular users to try and access

those resources to make sure they are available.

Create and share a folder

1. Log on to srv-1as the domain administrator and open windows explorer. Go to
Start>Programs—> Accessories> Windows Explorer.

=10l

Pl R Vew Favertss Took  te [ =]
olack = = - (3| Dsawch | yrokders Py | B W X o | TB-
s i vt =] @oe
Fukbars =l = | 2y
e ] & =2 &
- My Documents L s Floppy  Local Dk (C:) Compact Disc
: SRY-1 ) [1:5]
5 (¥ My Nebwork Flaces .
Recyde Bn Selnct o e b viow i et
B Inbermet Explorer descrighion. .
Control Panel

Disgdarys the Flos ared Folders on
yiur comguber
Py
X e Dot
& it pes
Hetwork, ond DAk U0 Connections

2. Double click on the C: drive, and then from the File menu select New—> Folder.

[EX Local Disk {C:)

Fle Edit ‘iew Favorites Tools  Help

Create Shorfout @ i
Delete 5 Briefcase
R
En30S ﬁ Eitmap Image
[ WordPad Document
Close Rich Text Document:
————
é’ 3% Floppy (A Text Document
i [#-=) Local Disk (]
I Pe— @ Wave Sound

Properties

:
=
=
i
E

3. Name the new folder Tools and then right click on the folder and select Sharing.

Dacuments  Program Filss — WINNT
and Settings
Tools
Explore
©pen
Search.
g Send To 3
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4. 'This will open to the Sharing tab on the properties page of the folder. To share the
folder, select the Share this folder option, leave the default share name Tools and click
OK. There should now be a hand underneath the folder showing that the folder is being
shared.

[1ack Properties 211
Giormual  Sharn | Secusty |

- “Wiou can share this fokdes among oher users on your
h_—.\-l rostveock. s mruabie sharig e thas Rolds, clck: Shase this
fokdat.

£ [0 ok sham s older
(51 Sbuaen s bokder

Shape ramer [ Tooks
Commenmri
Uit 7 M alowsd

 Alow _l; Ugms

To el parmaceaons bor how usees scomes e P
fokdar cves the retwedk, chek Pemssnsns. Pt |

kmmmronw oy Cacdug

[3 Coeed | ioply

5. Now create another shared folder and name it Admin Tools on the C: drive. This
folder will be used to store support tools for administrators only and will not be
published in Active Directory.

6. In order for users to search the Active Directory database for this shared folder it will
have to be published manually. Shared folders are not published into Active Directory
automatically. You can publish a shared folder into Active Directory and place it into
any container you want for organizational purposes. When you publish the shared folder
all you are doing is creating an object for it in the Active Directory database. Close
Windows Explorer and open the Active Directory Users and Computers console.
Right click on benandbrady.com domain located in the left pane and select
New->Shared folder.

4 Active Directory Users and Computers

| &5 console  window  Help
| aten wew ||« » | 2m BB 28
Treel benandbrady.com 7 objects
[ acove Ovectory Users andconp [ Heme [ Type
b Eenandbrady.com (Dguitin buikinDomain
Delegate Control... Organization.
Find... puters Container
Connert to Domain... ain Contr.... Orgarization
Connect ko Domain Cortraler.,,  fignSecuri... Container
Operations Masters. Organization.
Al Tasks »  Contact
o G
i »
e Organizational Linit

Hew Windaw from Here
Printer

Refresh User
Export List...

Properties

Help
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7. 'This will bring up a screen where you enter the name and the network path (UNC) of
the new-shared folder. Type in Tools for the name of the share and then the network
path (UNC) to the shared folder. This is the name of the computer the shared folder
resides on, followed by the actual name of the shate. Type in \ \srv-1\tools for the
network path of the shared folder and click OK.

Mew Object - Shared Folder x|

% Create in:  benandbrady.com/

Mame:
|Tw\s

Metwark path [Viserverishare]:
I\\srv-1\tou\d

Cancel

8. You will now have a shared folder object named Tools located in the domain. It can be
moved into other containers just like any other object in Active Directory.

Tree I benandbrady.com & objects

@ Active Directory Users and Comp | MEMe [Type [ Deseription |

@ benandbrady .com (ZBuitin builtinDomain
Ch Organizational ..,
(2 Computers Container Default container for upgr...
(] Domain Contr ..., Organizational .., Default container for new .,
DFnreignSetum. .. Container Default container For secu...
M (rganizational ...
[(Ausers Container Default container For upar...
Sodls Shared Folder

9. The next thing you need to do is create keywords for the shared folder. This way, users
who don’t know the exact name or path to the share can use keywords to find it in
Active Directory. Open the Properties of the Tools shared folder in the Active
Directory Users and Computers console by double clicking on it. On the General tab
of the Properties page click on the Keywords button.

i

fiereral | Meraged By |

= Tes
Deserphor: l—

UNC reme: [[aampls Woerver'ahare]

[areTumss

=
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10. A screen will appear where you can enter the keywords to associate with the shared
folder. Employees must have access to this folder because it will contain forms they
need to use for benefits, payroll and requesting time off. Therefore you must enter
keywords that relate to any of those topics. Type in Payroll and click Add. That
keyword is now associated with the shared folder in Active Directory. Now add the
following keywords and any other words you feel may be associated with this folder.

Click OK when you are done.

Keywords: Payroll, Forms, Vacation, and Sick Leave

keywords 2]
Tuvpe the information, and then click Add.
Ilnsurancel Add
Payrall Edit |
Farms
Wacation Remave |
Sick leave

ak. Cancel

Add, share, and publish a network printer

In order to add a printer to the network you must first install the printer locally on the server
and then share the printer similar to the way you would share a folder.

1. Add a printer to the server, stv-1. Go to Start=>Settings=>Printers. Double click on
the Add Printer icon to start the Add Printer wizard.

a ‘Windows Update

Programs

ments

0

Windows2000 Advanced Server

#start || 1] @ 53 || hactive Directory Users an...

Page 75 of 85

Fle Edit View Favortes Tools  Help
dmpeck - = - (3| Qysearch CFoders (HHistory | [5 TE
Address (30 printers

d
= t.,, Hheld Printer
rinters

This Folder contains information
abaut printers that are currently %
installed, and a wizard to help you

install new printers.

To get information about a printer
that is currently installed, right-click
the prirker's icon.

To instal a new printer, dlick the
Add Printer icon,

Select an item to view its
description,
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2. 'The first screen on the wizard is just a welcome screen, click on Next. The next screen
will ask you where the printer is attached. You can select the local printer option if the
printer is directly attached to the computer or the network printer option if you are
trying to add a printer that is already on the network. Select Local Printer and uncheck
the box underneath that says Automatically detect and install my Plug and Play
printer because you are not installing an actual printer. By leaving the box checked, the

wizard would try to find and install the printer, but you will get an error stating that the
printer can’t be found. Click Next.

3. Now the wizard will ask you to choose a port the printer will use. Select the LPT1
Printer Port and click Next.

Add Printer Wizard

Local or Network Printer
I the printer attached to your computer?

Add Printer Wizard

Select the Printer Port

Computers communicate with printers thiough ports t:’

If the printer is directly attached to your computer, click Local printer. [f it is attached to
another computer, or directly to the network, click Network. printer

Select the port you want your printer to use. If the port is not listed, you can create &

t
&+ Local printer new por
™ Automatically detect and install my Plug and Play printer & Use the follawing port
" Network piinter Part Description Printer =
Frinter Port
LFT2 Fiinter Foit
LFT3, Frinter Fait
COMT: Serial Part
COM2: Seial Part
M3 Smiial Pt =l

Note: Most computers use the LPT1: port to sommunicate with a local printer

" Create a new port
Type: Local Fart |

cBack [ Nest> | Cancel cBack [ mWew> EI\ Concel |

4. The next screen will ask you to specify the manufacturer and model of the printer.
This will install the drivers necessary for the printer to work on the Windows 2000
operating system. Select the manufacturer Generic and the model Generic / Text
Only. Click Next.

Add Printer Wizard

The manulacturer and mods! determine which printer to use: Q‘:’

> Selact the manufacturer and model of your printer. If your printer came with an instalation

&

L5  disk, click Have Disk. If your printer is nat isted, consult your printer documentation for a
compatibls printer

Manulacturers, Fiinters

Dicarix +| [Generic / Text Oy

Digital Generic |BM Graphics Spin
Epsan —! | Generic IBM Graphics 3pin wide
Fuitsu M5 Publisher Calor Printer

M3 Publisher Imagesetter

= |
Have Disk..

<Back [ mew> | cencel |
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The next screen will ask you to assign a name to the printer and to specify if you want
this to be your default printer for Windows-based programs. Type in Generic as the
Printer name and select Yes to make this the default Windows printer.

The following screen will ask you to specify whether you want to share this printer or
not. Select Share as to share this printer and leave the default name of Generic as the
share name.

Add Printer Wizard Add Printer Wizard
Name Your Printer 73 Printer Sharing %
You must assigh a name for this printer. v “You can share this printer with other network users -

Supply & name far this printer. Some programs da not support server and pritter name: Indicate whether you want this printer to be available to other users. IF you share this
combinations of mare thah 31 characters. printer, you must provide a share name.

Printer name: Do not share this printer

Sl " Share asf  |Generic

Do you want your Windows-based programs to use this printer as the default printer?
o Yes
 No

< Back I Next > :{I Cancel < Back IJ\ Hext > I Cancel
3

The next screen of the wizard allows you to place information about where the printer is
located and any other comments you may want to add to this printer. This is optional
and can be left blank, but it is a good idea to at least give it a location if you ever need to
know where it’s located in a big building. For the location type in: 5" Floor-East
Window and you can leave the Comment section blank or enter any comment you want.

Add Printer Wizard

Location and Comment 0
You have the option of supplying a location and description of this printer. w

“You can describe the lacation and capabilities of thiz printer. This infarmation may be
helpful to users.

Lacation: |5th Floor-E ast Window

Enmmen%l

< Back I Mest > I Cancel
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8. The next screen will ask you if you would to print out a test page to confirm that the
printer is working. Select No, because there is no actual printer to print out to, but it is a
good idea to print out a test page if you are installing an actual printer. Click Next. The
final screen will just be a summary of all the information you entered into the add printer
wizard. Confirm that all the information is correct and click on Finish.

Puiet Test Page . - 5
T Gonte thak the printes i ntalied properly. you Can St & lest page &V‘El{rﬂfbnu the Add Printer
080 you wank 4o [uink 5 bet pags” it harve: uaceseashaly compleled the ik Frter wizarel
 en “fiout speciied the lobowng prnter pefings
=W Hame: Gensnc
E Shacdar.  Gormm:
Fxt LFT1
Mol G / T Oy
Delaa o
Taspage: Mo
Lexcator: St Floe € it 'Wirchows
Comerat
To chove this waerd. chck Firnish,
sk Cancel <Bak T

9. You should now have a printer icon appear in the printers folder named Generic and a
hand underneath it indicating that the printer is being shared.

J File  Edit Wiew Favorites Tools  Help

J 4=Eack - = ~ | @Search L Folders @History |E’ L
J Address I Printers

= Add Printer
Printers

10. Printers are published in Active Directory automatically. The only time a printer will
need to be published is if the printer is installed on a pre-Windows 2000 computer. Try
to publish that printer anyway to see if it will work. Open the Active Directory Users
and Computers console. Right click on the benandbrady.com domain and select
New=> Printer.

4 Active Directory Users and Lomputers
|| Coneln wiedows el
| ation wew || = = [EB)[m|eF D6 2] 'E

“H‘l benandbrady.com O objects
[55 Active Drectery Usars and Comp [ ame | Type
(i Deudtin butirComan
| Delegate Control.... Crganistion
1 And. s Conksner
1 Conect bo Comain... sin Corkr.... Crganizatior
| Eonnect to Doman Controlier. .. i Secu.,. Cortsine
L Operstions Masters... Cryanization
t Computer
A8 Tasks b Contact
Groug
Wiewr
Crganizational Link
My Wik from Here
Rgfresh User
ExpirtList... harnd Folder
Propertios
Help
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This will bring up a screen where you enter the network path of the shared printer. Type
in the path to the generic printer on srv-1 (\\strv-1\generic) anyway and click OK.
5

}2 Crosla i bananchuady com/

oG coem

You will get an error telling you that the printer cannot be published and to use the
printer folder to publish printers on Windows 2000 computers. Click OK on the error
message and then Cancel on the new printer object screen.

Active Directory ﬂ
This printer canmot be published. To publish printers on Windows 2000 computers, use the Printers Folder.

Close the Active Directory Users and Computers console and open the printers
folder. Right click on Generic printer icon and select Sharing.

o

Printers

i I <
fready EEETT .
Location: Sth Floor-East Window Use Printer OFfline

This will open to the Sharing tab on the Properties of the printer. Here you can un-
share or share the printer if you did not share it in the wizard and add any additional
drivers that may be needed. Remember that printers are automatically published in
Active Directory when they are installed on a Windows 2000 computer. If you need to
remove the printer from Active Directory all you must do is uncheck the box that says
List in Directory and vice versa if you need to add it back to the Active Directory.
Leave the printer published in Active Directory, click OK and close the printers folder.

T [ reeew [ g |
Shaing | Pote | Advenced | Seo

£ Mot shared
' Shared as: Generic
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Create a contact in Active Directory

A contact may be created in Active Directory to list information for someone without
having to create an actual user account. Contacts are used to store information for people
that are outside of your company. For example, business partners, vendors, and possibly
customers. Contacts are most useful if you are running Microsoft’s Exchange Server
(Microsoft’s Mail Server product) because they allow you to integrate your mailing lists with

your Active Directory structure.

1. Open the Active Directory Users and Computer console. Right click on the
benandbrady.com domain and select New=> Contact.

..fl Active Directory Users and Computers
J @ Console  Window  Help

| acion vew || « o | @@ &

BE 2| giE

Tree I

benandbrady.com & objects

L) active Directory Uisers and Comp [MEme [ Tpe [o

B [Pt builtinDamain
Delegate Contral... Organizational ...
Find... Container D
Connect ko Damair. .. ... Organizational ... D
Connect ko Domain Controller. ., ... Container D
Operations Masters.., Organizational ...
Al Tasks b M
Yiew L4 S

Crganizational Unit:
Prirker

Refrash User

Expart List... Shared Folder

New Window from Here

2. 'This will bring up a screen for you to enter the new contact name. Type in Joe for the
first name, Ship for the last name and the full name should appear as Joe Ship. Click

OK when finished.

New Object - Contact

Createin.  benandbrady.com/

First name:
Last name:
Full name:

Display name:

IJUe Initizls:
ISh\d

I.Jne Ship

Ok Cancel
3

x|
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Now double click on the contact Joe Ship in the right pane to open the Properties. On
the properties of the contact you can add more detailed information like telephone
numbers, email addresses, etc. Type in Shipping Company for the Description of this
contact and enter any seven-digit telephone number in the Telephone Number field.
You can view the other tabs to see what additional information you can add about this
contact. Now users on the benandbrady.com domain can do a search within Active
Directory to find the information they need for this contact. Click OK when finished
and close the Active Directory Users and Computer console.

21

Germal | Adsess | Telephores | Depsrizion | Merbes 0 |

5o deeshe

First namer: = Iniisly

Latt e [tm:

Diplay name: [

Dpstrghen |5#epprg Comguary

Oifce: [

Telephone rumber. (1234567 Other...

Emad |

g ox L ow. |

Con) o |

Perform Active Directory searches for published resources

Shared Folder-Scenario

Jill Smith needs to fill out a form requesting vacation time. They told her where the forms
were located on the network the first day she started but now almost a year has gone by and
she can’t remember where it is. She does know how to search the Active Directory for
resources though. Maybe she can find it by doing a search with the keyword vacation.

1.

Log on to client-1 as the user Jill Smith (jsmith). On the desktop, double click on My
Network Places. In the My Network Places folder double click on the Entire
Network icon. Then the Entire Network folder gives you links to all of the options that
you can search for within the company network. Click on the link entire contents to
see the directory.

i —

Entiré Network

Use the links below ta search For
things within vour corporation.

Search for printers
Search for compukers
Search for people

earch for files or folders

I
e

My Network Places

‘You may also view the entjre
- contents of the network. é j
Entire Network
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2. Double click on the Directory and it will open to show you all the domains that the
directory contains, which in this case is just benandbrady. Right click on benandbrady

and select Find.

— B

Entiré Network

Directory

&
=

Microsoft
Winda, ..

Directory - " open

benandbrady

[

Explore

Create Shortcut

Properties

3. This will bring up a search screen where you can search for objects within the Active
Directory. Click on the Find drop down menu and select Shared Folders.

4% Find Users, Contacts, and Groups

File Edt View Help

—Iojx|

Finc: [Users, Contacts, and Groups =] I [39 benandbiady

Users, Contacts, and Gioups
Computers

Fiins
Na) e

U

el

iga

o
P8 Cstom Search

ed|
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4. 'This will give you option of searching by name or by keyword for the shared folder.
Type in the keyword vacation and click on the Find Now button.

4% Find Shared Folders

File Edit View Help
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5. This should list all of the shared folders that have the keyword vacation associated with
them. In this case there is only one, which is the folder that contains the necessary

forms. This folder can be opened by double clicking on the share.
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6. Now try to do a search for the Admin Tool folder. Even though the share does exist
on the network it will not be found in Active Directory because it was not published.
Now close all windows and log off the user Jill Smith.

& Find Shared Folders 3 =10l x|
File Edit Wiew Help

Find: [Shared Folders =] n [ benandbrady x| Browse

Shared Folders | Advanced |
Stop
Clear Al

X
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Shared Printer-Scenario

Jack Straw needs to connect to the new printer that was installed right behind his cubicle.
Unfortunately, he doesn’t know what the printer share name is. He is going to try to add it
to his computer anyway.

1. Log on to client-1 as the user Jack Straw (jstraw). Open the Printers folder and
double click on the Add Printers icon.

Flo  ES Vow  Favortes  Took el
= - = - (L Psewch ifckkns (Prmery | A0 00
Ao |41 priveees

e

i P

Ta et information sbouk & prinker
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2. 'This will start the Add Printer wizard. The first screen is just a welcome screen, click
Next and the next screen will ask you what type of printer you want to install. The
Network printer is the only one that will be available because the user does not have
permission to install a printer locally. Click Next.

Add Printer wizard

Local or Network Printer

Is the printer attached to your compuiter? v

1f the printer is directly attached to your computer. click Lacal printer. [Fitis attached to
another computer, or directly to the network, click Network printer.

£ LLocal printer
| Automatically detect and install my Plug and Play printer
& Netwiork printer

<Back [ Hem> | Cancel
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3. The next screen gives you different options to find the printer. Select the Find a

printer in the Directory option and click Next. This will bring up a search screen for
printers. Leave the entries blank and it will give you all of the shared printers available in
the directory. Click on Find Now and you will get the printer named Generic to appear
because it is the only printer in the domain. You can see that the location of the printer
is the correct one for this user. Double click on the Generic printer.
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This will take you to the next screen of the wizard that asks you if you would like for it
to be the default printer. Select Yes and click Next. The Final screen will show the
information you placed in the wizard. Confirm that it’s all correct and click Finish. You
now have the Generic printer icon appear in your printers folder as the default printer.
Close the printers folder.

e Add Printer
Printers

Generic on sry-1

Contact-Scenario

Jack’s boss told him to call the representative from the shipping company and ask him why
he billed the marketing department for a shipment. He gave Jack the phone number but
Jack has lost the number in his mess of an office. He remembers that his boss got the
number from Active Directory in the first place, so now he is going to try and do a search in
Active Directory for the contact.

1.

Open My Network Places to the benandbrady directory. Right click on
benandbrady and select Find.

e
Directory Open
Explore

benandbrady
Create Shortout

Properties
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2. You will do a search for Shipping, in hopes of finding the contact for the shipping
company. You should get a result for Joe Ship. Double click on the contact and you

will be able to get all information you need in order contact him.
' =loix]

-.','V Find Users, Contacts, and Groups

File Edit “iew Help
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